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What is Terminal?

Microsoft Terminal is a communications application. With Terminal you can connect your computer to 
other computers and exchange information. For example, you can use Terminal to hook up to an online 
news service or to online bulletin boards.
If you are new to communications applications, you may want to read an introductory book on the 
subject. The topics presented here assume that you have a basic understanding of telecommunication 
concepts and terms.



Hardware Requirements
You can connect and transfer files to another computer in the same room or to computers in different 
offices or buildings.
To connect two computers in the same room, you need a null modem cable or adapter. Each machine 
must have its own communications application running. Terminal or another communications application 
will do.
To communicate with computers in different locations, you need the following hardware:

An unused serial port
A modem
A cable to connect the modem to the port

See your hardware manual or computer dealer for more information about these components.



Before You Start
You need to know the communications settings for the other computer before you can connect. The 
basic settings include:

Baud rate
Data bits
Stop bits
Parity
Flow-control method (handshaking)

If you use an online service, this information is in the introductory package you received from the 
service.
You can also use Terminal settings files (.TRM) created with previous versions of Windows. For 
example, if you used Windows 2.0 to create a Terminal file that was for connecting to a mail system, you
can still use this file to connect to the mail system.



A Sample Session
Suppose you want to hook up to a remote system for online services. You might want to read mail and 
then download a file from the service. Your session might go like this:
1 Start Terminal.
2 Change settings, such as the phone number to dial.
3 Dial the remote computer.
4 Transfer a file.
5 View a file.
6 End the session.
Your actual sessions might vary. You might not need to transfer or view files, or you might want to use 
settings that you saved previously.

Related Concepts



Concepts
How a Session Ends
How Settings Affect a Session
How Terminal Connects to the Remote Computer
How Terminal Transfers Files
How to View a File



remote
Describes a computer that is connected to your computer through a modem and over telephone lines.



How Settings Affect a Session
Each Terminal session requires that you indicate settings for the remote computer. You can save your 
settings in a file to use again, or you can change settings for a particular session.
The settings include:

The phone number for the remote computer. The number can include pauses to wait for an 
outside line.    

Terminal emulation. You can tell Terminal to emulate the type of terminal required by the remote 
computer, such as VT-100.

Terminal preferences. You can change the terminal mode, add carriage returns and line feeds, set
the number of columns for your monitor, change the cursor shape, set a font for your display, select a 
language, change the buffer size, and display scroll bars.

Communications settings. Your baud rate, data bits, stop bits, parity, and flow control must match 
the remote computer’s settings. Check your modem documentation and the information from the remote 
service.

Modem commands. Terminal includes commands for several popular modem types. If your 
modem is not included, you can enter the appropriate commands for it.

Related Procedure



example
You might need to dial 9, then wait for a tone to dial out from your office. This string 9,,1-800-555-1212 
dials the 9, then pauses for 4 seconds before dialing the remaining numbers.



How Terminal Connects to the Remote Computer
Once you specify the settings for a session, you can call the remote system. Terminal uses the phone 
number you specified, or it prompts you for a phone number.
Terminal dials the modem, then waits for a reponse from the other computer. If you are connecting to a 
service, the response is usually a request for your log-on name and password.
If you are connected directly to another computer with a cable, you do not need to dial a phone number.

Related Procedure



How Terminal Transfers Files
Once you have called another computer, you can send or receive files. Terminal sends and receives files
using two basic methods: text transfer or binary transfer.
Text transfer works only with unformatted text files. Text transfer can be quicker than binary transfer 
because there is less error checking.
You use binary transfer for sending text files or binary files, such as program files. Binary transfer checks
more rigorously for errors and loss of data. Windows supports XModem/CRC and Kermit protocols.
Once you have specified    text transfer or binary transfer, you can send or receive the file.



text files
Files prepared with a text editor or word processing application and saved unformatted. Text files are 
sometimes called ASCII files. They contain only printable ASCII characters and control codes such as 
carriage returns and line feeds.



binary files
Files containing ASCII and extended-ASCII characters. Binary files are not converted or translated 
during the transfer process. Program, or application,    files are binary files.



Binary Transfers
When you use binary transfer, you need to set the transfer method, then send or receive the file. 
Binary transfer uses standard protocols for data transmission. You do not need to know the 
communications settings for the remote computer, only the protocol. Terminal supports XModem/CRC 
and Kermit protocols.
When you send a binary files, Terminal sends a copy of the file on your disk. The original file remains on 
your disk.
When you receive a binary file, Terminal stores a copy on your hard disk. The original file remains on the
remote computer.
During file transfer, Terminal displays a status bar to indicate transfer progress. Click        to see the 
status bar for sending a file.

Related Proceduures



Procedures
Receiving Binary Files
Sending Binary Files
Setting Up Binary Transfers



When you send a file, the status bar indicates the current percentage sent. When you receive a file, 
Terminal does not display the percentage received.



Text Transfers
When you transfer text, you need to choose a transfer method, then send or receive the file. 
Terminal provides three methods for transferring text files. The type you use depends on your remote 
computer.

Most remote computers use the standard flow controls set in the Communications settings.
Some remote computers transfer text one character at a time. This method is very slow.
Some remote computers transfer text one line at a time. This method provides an interactive 

dialog with the remote computer.
When you send a text files, Terminal sends a copy of the file on your disk. The orignial file remains on 
your disk.
When you receive a text file, Terminal stores a copy on your hard disk. If a file with the same name 
already exists on your disk, you can overwrite the file or append the text to the existing file. The original 
file remains on the remote computer.
During file transfer, Terminal displays a status bar to indicate transfer progress. Click        to see the 
status bar for sending a file.

Related Proceduures



Procedures
Appending Incoming Information to Existing Text Files
Overwriting Incoming Information to Existing Text Files
Receiving New Text Files
Selecting Standard Flow Control for Text File Transfers
Sending Text Files
Transferring Text Files a Character at a Time
Transferring Text Files a Line at a Time



When you send a file, the status bar indicates the current percentage sent. When you receive a file, 
Terminal does not display the percentage received.



How to View a File
With Terminal you can view a text file on your disk before    you send it or after you receive it. Terminal 
will display the file one character at a time in the window. Because the file can scroll quickly past, you 
may need to pause, resume, or stop the display. 
You can view a file from disk while connected to a remote computer, but not during a file transfer.

Related Proceduures



Procedures
Pausing, Resuming, and Stopping Transfers
Viewing Text Files



How a Session Ends
The recommended steps for ending your session with the remote computer are:

Allow any ongoing file transfers to finish.
Disconnect from the remote by typing the exit or log-off command for the remote computer.

Remember to log off the remote computer before you hang up the modem. You can avoid additional 
phone or line charges for your session with a remote service by logging off and hanging up yourself.

Hang up the modem.
Save your settings if you want to use them again.
Exit Terminal.
Related Proceduures



Procedures
Disconnecting from the Remote Computer
Saving New or Renaming Existing Settings Files



The Terminal Buffer
Terminal has a buffer area in the window to store the text from a communication session. The text can 
include the prompts from the remote computer and your responses, text from a file you receive, or text 
that you paste from the Windows Clipboard. You can scroll through the buffer just as you would scroll 
through a window in another Windows application.
As you receive or type new text, the buffer fills up. The text at the top of the buffer is deleted to add new 
text at the bottom. The buffer can hold about 100 lines of text at a time. You can change the buffer to 
hold up to 400 lines.
When you paste text into the buffer, Terminal sends the text to the remote computer. You can also send 
text that is already in the buffer. For example, viewing a file from your disk places text in the buffer, but 
does not send the text. You can select part of the text in the buffer, then send the selected text to the 
remote computer.

Related Proceduures



Procedures
Selecting Text
Sending Selected Text to the Remote Computer
Setting the Buffer Size
Viewing Text Files



Function Keys
With Terminal, you can assign communications commands and keystrokes to function keys. To execute 
the commands, you press the function key and CTRL+ALT. For example, you could assign your log-on 
command sequence to F1. Then, you would type CTRL+ALT+F1, and Terminal would execute the log-on 
command sequence for you.
If you assign function keypad names to the function keys, you can also use the function keypad to 
execute the commands.

Related Proceduures



function keypad
Keypad of names for the function keys. To execute a function key, you can click the keypad name.
You can assign up to 32 function keys. The keys are grouped into four levels of eight keys each.



Procedures
Assigning Function Keys and Their Commands
Assigning up to Four Functions to a Key
Showing and Hiding the Function Keypad
Using the Function Keys You Assign



function keys
The keys starting with "F" at the top of your keyboard.



How Terminal Prints
You can print text in two ways:

Turn on Printer Echo to send incoming text to the printer and to yourscreen. If you want to print 
your keystrokes as well, you need to turn on Local Echo when you specify terminal modes.

Print selected text in the buffer.
Related Procedures



Procedures
Changing Printers and Printer Options
Printing Incoming Text
Printing Selected Text
Specifying Terminal Modes

















New Command

Creates a new file.
A Terminal file consists of the settings you specify in a communications session.
When you choose this command, Teminal lets you saves changes to the current file.

Related Procedure



Open Command

Opens an existing file.
A Terminal file consists of the settings you specify in a communications session.
When you choose this command, Terminal lets you save changes to the current file.

Related Procedure



Save Command

Saves changes to the current file.
A Terminal file consists of the settings you specify in a communications session.
When you choose this command, the file remains open so you can continue working on it.

Related Procedure



Save As Command

Saves a new file or an existing file under another name.
You might want to rename a file so that you can change an existing file without modifying the original.
If you don't specify an extension, .TRM is automatically assigned to the filename. If you specify an 
extension, it overrides any automatic extension.
If you name your file TERMINAL.TRM, Terminal will automatically open this file next time you start 
Terminal from File Manager or Program Manager.

Related Procedure



Printer Setup Command

Sets printer options for Terminal before printing incoming text.
In the dialog box, you can:

Select a default printer for Terminal.
Choose Setup and change options for the printer.

The available options depend on the type of printer selected.
Related Procedures



Procedures
Changing Printers and Printer Options
Printing Incoming Text



Exit Command

Exits Terminal and closes the Terminal window.
If the current file is unsaved, Terminal lets you save it before exiting.



Copy Command

Copies selected text onto the Clipboard.
Once you copy text onto Clipboard, you can send it to a remote computer or paste it into another 
application.

Related Procedures



Procedures
Copying Text onto the Clipboard
Sending the Clipboard Contents



Paste Command

Sends a copy of the Clipboard contents to the remote computer.
The contents of the Clipboard remain unchanged.

Related Procedure



Send Command

Sends selected text to the remote computer.
The Send command copies selected text from the Terminal window and places it onto the Clipboard, 
erasing the previous contents of the Clipboard. Then the command sends the Clipboard contents to the 
remote computer.
In Terminal, choosing this command is the equivalent of choosing both the Copy and Paste commands.

Related Procedure



Select All Command

Selects all text in the Terminal window and scroll buffer.
After you select the text, you can choose the Send command to send the text to the remote computer . 
Or, you can choose the Copy command to copy it to the Clipboard, then switch to another application 
and choose Paste to paste the text into a document.

Related Procedure



Clear Buffer Command

Clears the contents of the scroll buffer.
By clearing text you received and are storing in the buffer, you can free up memory.

Related Procedure



Phone Number Command

Specifies the phone number and other options for dialing the remote computer.
You can specify:

The phone number.
That Terminal wait a specified number of seconds for a connect signal before timing out.
That Terminal redial after timing out.
That the system bell sound when you've made a successful connection to the remote computer.
Related Procedure



Terminal Emulation Command

Specifies the terminal emulation type.
You can choose TTY (Generic), DEC VT-100 (ANSI), or DEC VT-52.

Related Procedure



Terminal Preferences Command

Sets preferences for how your computer terminal behaves during a session.
You can specify:

That Terminal wrap incoming text, display keystrokes in the window, and turn on the system bell 
for the remote computer.

That Terminal add carriage returns and linefeeds for inbound and outbound transfers.
Whether you select Inbound or Outbound depends on how the remote system handles the end of a 
line and what it expects from other computers. Click        for an example of how to use these 
options.

An 80-column or 132-column monitor.
You can specify 132 if you want an 80-column monitor to behave as if it were a wide monitor, and vice
versa. If you specify 132, Terminal will reserve 132 columns for text whether or not 132 columns are 
entered or received. Therefore, specify 132 only if you must receive text in 132 columns.

Cursor type: blinking or solid, and underline or block.
Terminal font and font size.
A country setting for file transfers in a language other than English.
Whether scroll bars show in the Terminal window.

Use Terminal's scroll bars to see information currently not visible in the window.
The number of lines of information Terminal can store in the scroll buffer.

If you type a number higher than available memory permits, Terminal sets the buffer lines to the 
largest number permitted.

Related Procedures



Procedures
Selecting a Different Language
Selecting Fonts
Setting the Buffer Size
Showing the Scroll Bars
Specifying Carriage Returns and Linefeeds (CR to CR/LF)
Specifying Columns for Your Monitor
Specifying the Type of Cursor
Specifying Terminal Modes



Function Keys Command

Defines how function keys perform during a Terminal session.
You can:

Assign text and control codes specifying the functions the keys will perform.
For example, you could type "hello" in the Command box that corresponds to the "type hello" key 
name. Click        for examples of control codes you could assign.

Assign up to four functions to each function key.
You assign these functions in sets--that is, one group of keys has one set of functions, a second 
group has another set, and so on.

Show the function keys in the keypad at the bottom of the Terminal window.
Assign keypad names to the function keys.

For example, you could type "type hello" as the name of a function key for a prompt command. 
Names are optional.

To execute the command of a function key, click the keypad name, or press CTRL+ALT and the function 
key.

Related Procedures



example
The following are control codes you could use:

Control code Function
^A to ^Z Sends control code A to Z to the remote computer.
^$D<NN> Causes Terminal to delay <NN> seconds before continuing.
^$B Causes Terminal to transmit a break code of 117 milliseconds in duration.
^$C Chooses Dial from the Phone menu.
^$H Chooses Hangup from the Phone menu.
^$L1 to ^$L4 Changes to another level of key groups in which keys are defined.
You can assign a number of codes and text strings to a function key.



Procedures
Assigning up to Four Functions to a Key
Assigning Function Keys and Their Commands
Showing and Hiding the Function Keypad



Text Transfers Command

Sets the options for text file transfers.
Your options for flow control include:

Standard--This option uses the method specified with the Communications commands.
Character at a Time--This option causes Terminal to delay between characters or wait for a 

character echo.
Line at a Time--This option causes Terminal to delay between lines or wait for a prompt string.

You can also specify at what column outgoing text will be wrapped.
Related Procedures



Procedures
Selecting Standard Flow Control for Text File Transfers
Setting Word Wrap for Text File Transfers
Transferring Text Files a Character at a Time
Transferring Text Files a Line at a Time
Understanding Text and Binary Transfers



Binary Transfers Command

Sets the XModem/CRC or Kermit protocol for binary transfers.
Related Procedures



Procedures
Setting Up Binary Transfers
Understanding Text and Binary Transfers



Communications Command

Sets the communications parameters.
You can set:

Baud Rate--To specify the transfer rate of the two modems.
Data Bits--To specify the number of data bits in the data packets sent between the two 

computers.
Stop Bits--To specify the time between transmitted characters.
Parity--To specify the parity type.

Parity refers to the error-checking method used.
Flow Control--To tell Terminal what to do if the buffer becomes too full to receive more data from 

the remote system.
Connector--To select the communications port your modem uses.
Parity Check--To show the byte in which an error occurred.
Carrier Detect--To use the modem signal.

When Carrier Detect is selected, Terminal uses the carrier detect signal to determine whether the 
modem is on line. When carrier detect is off, Terminal looks at the modem response string to 
determine if it is connected.

Related Procedure



Modem Commands Command

Specifies modem commands.
When you choose Modem Commands, Terminal displays some of the commands for a given type of 
modem. You can change the default modem type and display a different set of commands. If your 
modem is not one of the types that Terminal lists, you can modify the commands of a modem type, or 
select None and enter the commands yourself.

Related Procedure



Printer Echo Command

Prints your incoming text and keystrokes.
Printer Echo turns printing mode on and off. When printing mode is on, all information received by 
Terminal is sent to the printer. If Local Echo is turned on, your keystrokes are also sent to the printer.
Keystrokes and incoming informaton are printed only if you have connected and installed a printer. 
Keystrokes and informaton are automatically printed on the default printer.

Related Procedures



Procedures
Installing New Printers
Printing Incoming Text
Specifying Terminal Modes



Timer Mode Command

Times your Terminal sessions.
When you show the function keypad, Terminal also displays the system time or timer in a box in the 
window's lower-right corner. (The system time is the time of day; the timer is for timing the length of your 
Terminal session.) Use this command to switch from the system time to the timer.

Related Procedures



Procedures
Showing and Hiding the Function Keypad
Timing Terminal Sessions



Show/Hide Function Keys Command

Shows or hides the function keypad, and the timer or system time.
The function keypad is used to choose function keys you assign with the Function Keys command. 
These function keys execute communications commands you might ordinarily have to type.
The system time is the time of day; the timer is for timing the length of your Terminal session.

Related Procedure



Dial Command

Dials and connects your computer to the remote computer.
Terminal uses the phone number specified with the Phone Number command or prompts you to supply 
the information.

Related Procedure



Hangup Command

Disconnects your computer from the remote computer.
CAUTION: You should signal the remote computer with an exit command before choosing this 
command. If you choose this command first, you will be disconnected from the remote computer, but its 
phone connection will remain off the hook. Your account might continue to be charged for connect time 
until the remote system detects that the connection has been dropped.

Related Procedure



Send Text File Command

Sends a text file to the remote computer.
Use this command to send files you have saved in ASCII format (with minimal formatting codes).
In the dialog box, you can specify:

The filename.
Whether to strip or append linefeeds after a carriage return.
Related Procedures



Procedures
Sending Text Files
Understanding Text and Binary Transfers



Receive Text File Command

Receives a text file from the remote computer.
Use this command to receive files that were saved in ASCII format (with minimal formatting codes).
You can specify:

A name and directory for a new or existing file.
If you don't specify an extension, .TXT is automatically assigned to the filename. If you specify an 
extension, it overrides any automatic extension.
If you choose the name of an existing file, Terminal will overwrite the file with the file it receives.

Whether to append an existing file.
This option adds incoming text to the end of an existing file.

Whether to save some control codes in a text file.
This option lets you retain some of the file's formatting codes rather than save the file in pure ASCII 
form.

Whether to receive incoming text in tabular format.
Terminal will put tab characters between incoming text separated by two or more consecutive spaces.

Related Procedures



Procedures
Appending Incoming Information to Existing Text Files
Overwriting Incoming Information to Existing Text Files
Receiving Incoming Text Files in Tabular Format
Receiving New Text Files
Saving Control Codes in Incoming Text Files
Understanding Text and Binary Transfers



View Text File Command

Lets you view a text file before you send or receive it.
Use this command to view files saved in ASCII format (with minimal formatting codes).
In the dialog box, you can specify:

The filename.
Whether to append or strip linefeeds after carriage returns.

If you already specified linefeeds when you received a file, you might want to ignore these options.
Related Procedure



Send Binary File Command

Specifies and sends a binary file to the remote computer.
The binary file is sent according to the protocol specified with the Binary Transfers command.
You cannot pause or resume a binary file transfer. If Terminal is running as an icon during a transfer, the 
icon will flash when the transfer is either completed or fails. Restore Terminal to a window to continue 
your communications session.

Related Procedures



Procedures
Setting Up Binary Transfers
Sending Binary Files
Understanding Text and Binary Transfers



Receive Binary File Command

Names and receives a binary file from the remote computer.
If you specify the name of an existing file, Terminal overwrites the file with the file it receives.
You cannot pause or resume a binary file transfer. If Terminal is running as an icon during a transfer, the 
icon will flash when the transfer is either completed or fails. Restore Terminal to a window to continue 
your communications session.
Occasionally, a communications error prevents the successful transfer of data. When this occurs, the 
remote system will try again. When the maximum number of retries has been reached, Terminal cancels 
the file transfer. The Retries box at the bottom of the Terminal window displays the number of times the 
remote system has tried to send the data.
Terminal receives a file in binary file format according to the protocol specified with the Binary Transfers 
command.

Related Procedures



Procedures
Setting Up Binary Transfers
Receiving Binary Files
Understanding Text and Binary Transfers



Pause Command

Pauses a text file transfer.
You cannot pause a binary file transfer.
You can also pause a transfer by choosing the Pause button at the bottom of the Terminal window.

Related Procedure



Resume Command

Resumes a text file transfer that has been paused.
You cannot resume a binary file transfer.
You can also resume a transfer by choosing the Resume button at the bottom of the Terminal window.

Related Procedure



Stop Command

Stops a text or binary file transfer.
You can also stop a transfer by choosing the Stop button at the bottom of the Terminal window.

Related Procedure
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Specifying the Phone Number
You specify the phone number you want Terminal to dial when you choose Dial from the Phone menu.

To specify the phone number that Terminal will dial:
1 Choose Phone Number from the Settings menu.
2 Type the phone number in the Dial text box.

You can type parentheses and dashes, but they are not required. Type commas to provide any delays
needed for the number to be processed by the telephone system. Each comma inserts a delay of 
approximately 2 seconds.
Click        for an example.

3 Select the other options you want and click OK.

Use this option To
Timeout If Not Connected In Set the number of seconds Terminal waits for a connect signal from

the remote computer. 30 seconds is the minimum waiting time.
When one modem calls another, the originating modem waits for 
high-pitched answer tones and data signals. If a remote modem is 
busy with other calls or is being serviced, it may not answer with 
signals immediately.

Redial After Timing Out Dial the phone number again if a previous attempt failed to make a 
connection.

Signal When Connected Ring the system bell (beep) when a successful connection has 
been made.

Keyboard Procedure



example
The following string first dials a 9, then pauses for 4 seconds before dialing the 11-digit number shown:
9,,1-800-555-1212



Setting Terminal Emulation
With Terminal, your computer can emulate the terminal type required by the remote computer with which
you are exchanging data.

To set the terminal emulation type:
1 Choose Terminal Emulation from the Settings menu.
2 Select a terminal type.

The terminal types shown are the most common ones used by the large, mainframe computers that 
host online services. If you are not sure which terminal to use, select TTY. If you select TTY, the 
remote system receives formatting codes for only the carriage return, backspace, and tab characters.

3 Click OK.
To use the function keys for DEC VT-100 (ANSI) terminal emulation, you must also press the 
SCROLL LOCK key. If SCROLL LOCK is turned off, the function keys and arrow keys assume normal
Windows (not VT-100) functionality, such as F1=Help.

Keyboard Procedure



Specifying Communications Parameters
You must specify communications settings before exchanging information with another computer. Check
your modem documentation and the remote service package for the correct settings.

To specify communications parameters:
1 Choose Communications from the Settings menu.
2 Select the options appropriate for your system and the remote computer, and then click OK.

Use this option To
Baud Rate Specify the transfer rate of the two modems.

The most common settings are 300, 1200, and 2400 bits per second. Some 
modems can transmit at more than one baud rate, so check your hardware 
manual and select one that both systems can handle.

Data Bits Specify the number of data bits in the data packets sent between the two 
computers.
Most characters are transmitted in 7 or 8 data bits. A few computers require a 
setting of 4, 5, or 6 data bits, but they are rare.

Stop Bits Specify the time between transmitted characters.
Stop bits are not actually bits; they're the timing units between characters.

Parity Specify the parity type.
If you selected 8 data bits in the previous option, select no parity (None). Mark 
parity means that the eighth bit is always on (set to 1). Space parity means the 
eighth bit is always off (set to 0).
When Odd is chosen, Terminal adds up the individual data bits used to transmit
a character and then adds an eighth bit. If the sum of the bits in the character 
is even, the system will add a 1 bit to make it odd. If the sum is odd to begin 
with, Terminal will add a 0 bit to leave it unchanged. Even parity works 
similarly.
When no parity is used to transmit characters in the standard ASCII code set, 
the eighth bit is still transmitted, but it is ignored by both Terminal and the 
remote system.

Flow Control Indicate toTerminal what to do if the buffer becomes too full to receive more 
data from the remote system.
XON/XOFF causes your system to pause when the buffer fills. While this 
method (known as software handshaking) is the standard method for most 
systems, it cannot be used with a remote system that is configured for 
hardware handshaking.
Select Hardware if the remote system uses the hardware method. Select None 
if the remote system uses no overflow method. Select XON/XOFF if you don't 
know what flow control method is used.

Connector Select the communications port your modem uses.
If you're using a null modem, select None. Terminal uses COM1 if it is available
and then checks COM2, and so forth.

Parity Check See the byte in which a parity error was encountered.
Otherwise, you will see question marks (?) where the modem detected an 
error. The question marks will appear at every character not transferred 
correctly.

Carrier Detect Use the modem signal to detect a carrier signal.



When Carrier Detect is selected, Terminal uses the carrier detect signal to 
determine whether the modem is on line. When Carrier Detect is off, Terminal 
looks at the modem response string to determine if it is connected.
If your modem still isn't connecting after you have correctly set the other 
options, clear this check box to use Terminal's method and try connecting 
again.

Keyboard Procedure



Specifying Modem Commands
You can specify the command settings appropriate for your modem.
When you choose the Modem Commands command, Terminal displays the commands used for several 
popular types of modems. If your modem is not one of these types, you can enter the appropriate 
commands for it yourself.

To specify modem commands:
1 Choose Modem Commands from the Settings menu.
2 Select your type of modem from the Modem Defaults area.

When you select another type of modem, the commands change accordingly. These commands are 
explained in your hardware manual.

3 Change the commands as appropriate.
Click        for an example.
If you make a mistake, reset the commands by choosing the type of modem again.

4 Click OK.
Keyboard Procedure



example
If the Hayes commands are the same ones used by your modem, yet you want to use a phone system 
that has pulse dialing instead of tone dialing, you would change the Hayes Dial Prefix command from 
ATDT to ATDP.



Timing Terminal Sessions
When you show the function keypad, Terminal also displays the system time or timer in a box in the 
window's lower-right corner.
When you choose the timer, it is set to 00:00:00. Terminal then tracks how long you have been 
connected to the remote system. That way, you can monitor the length of your hook-up time and avoid 
charges you did not anticipate.

To time your sessions:
1 Make sure the function keypad is visible.
2 Choose Timer Mode from the Settings menu.

The timer starts.
3 Choose Timer Mode again to reset the timer.

Or click the time display to switch between the system time and timer without resetting the timer.
Keyboard Procedure



Specifying Terminal Modes
To specify terminal modes:

In the Terminal Preferences dialog box, select the appropriate Terminal Modes check boxes:

Use this option To
Line Wrap Wrap incoming characters to the next line if they are running past the last 

specified column.
Click        for an example of when to use Line Wrap.

Local Echo Display your keystrokes on your terminal. This option allows you to see the data
you are sending to the remote computer as you type it.
Click        for an example of when to use Local Echo.

Sound Turn on the system bell (or beep) for the remote computer.
Keyboard Procedure



example
If the host terminal uses 132-column lines and you have an 80-column terminal, select this option. When
Line Wrap is not selected, incoming characters to the right of the specified column width are lost.



example
If the remote system echoes your characters back to you (known as remote echo), do not select Local 
Echo or you will see duplicated characters on your terminal. If the remote system is not configured for 
remote echo, select Local Echo to display the outgoing characters as you type them.
The remote system may operate in half or full duplex. Half-duplex systems cannot echo your keystrokes 
to your screen. Full-duplex systems can echo your typing.



Specifying Carriage Returns and Linefeeds (CR to CR/LF)
To cause a carriage return to be interpreted as a carriage return plus a linefeed:

In the Terminal Preferences dialog box, select the Inbound and/or Outbound check boxes.
You can select Inbound, Outbound, both, or neither. If you select Inbound, carriage returns in any text 
coming from the remote computer will be interpreted as carriage returns followed by linefeeds. If you 
select Outbound, you are assuming that carriage returns you send will be interpreted by the remote 
computer as carriage returns followed by linefeeds.
Whether you select Inbound or Outbound depends on how the remote system handles the end of a 
line and what it expects from other computers. Click        for an example of how to use these 
options.

Keyboard Procedure



carriage return
Moves the print head or cursor to the left margin (depending on the computer type).



linefeed
Moves text on a printer or monitor down one line.



example
If the remote system sends carriage returns only, select Inbound to make all incoming carriage returns 
act like a carriage return followed by a linefeed. If the remote system sends carriage returns followed by 
linefeeds, do not select Inbound; if you do, each carriage return will be followed by two linefeeds. The 
same holds true of Outbound; if the remote system expects to get carriage returns and add its own 
linefeeds, do not select Outbound.



Specifying Columns for Your Monitor
To specify columns:

In the Terminal Preferences dialog box, click the 80 or 132 option button.
You can specify 132 if you want an 80-column monitor to behave as if it were a wide monitor, and vice
versa. If you specify 132, Terminal will reserve 132 columns for text whether or not 132 columns are 
entered or received. Therefore, specify 132 only if you must receive text in 132 columns.

Keyboard Procedure



Specifying the Type of Cursor
To specify how the cursor will appear:
1 In the Terminal Preferences dialog box, select the Block or Underline option to specify the cursor's 

shape.
2 Select the Blink check box if you want a blinking cursor.

Keyboard Procedure



Selecting Fonts
To select a terminal font:
1 In the Terminal Preferences dialog box, select one of the fonts from the Terminal Font box.
2 Select a font size.

Characters you type or receive will appear in the specified font and font size.
Keyboard Procedure



Selecting a Different Language
Use this setting to send and receive data in another language.

To select a different language:
In the Terminal Preferences dialog box, select a setting from the Translation box.

By selecting a country name, you specify which International Standards Organization, 7-bit character 
set to use. Make sure the host computer recognizes the character set you select.

Keyboard Procedure



Showing the Scroll Bars
Use Terminal's scroll bars to see information currently not visible in the window.

To show the scroll bars:
In the Terminal Preferences dialog box, select the Show Scroll Bars check box.
Related Procedure
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Setting the Buffer Size
To set how many lines of information can be saved in the buffer:

In the Terminal Preferences dialog box, type a number between 25 and 400 in the Buffer Lines 
text box.

If you type a number higher than available memory permits, Terminal sets the number of buffer lines 
to the largest number permitted.

Related Procedure
Keyboard Procedure



Assigning Function Keys and Their Commands
By assigning function keys, you can automatically execute communications commands that you might 
ordinarily have to type.

To assign function keys:
1 Choose Function Keys from the Settings menu.
2 Type a name for each function key in the Key Name box.

For example, you could type "type hello" as the name of a prompt command. Names are optional.
3 Type text and/or codes in the Command box to define each function key.

For example, you could type "hello" in the Command box that corresponds to the "type hello" key 
name. Or you could type any of the following codes.

Control code Function
^A to ^Z Sends control code A to Z to the remote computer.
^$D<NN> Causes Terminal to delay <NN> seconds before continuing.
^$B Causes Terminal to transmit a break code of 117 milliseconds in duration.
^$C Chooses Dial from the Phone menu.
^$H Chooses Hangup from the Phone menu.
^$L1 to ^$L4 Changes to another level of key groups in which keys are defined.
You can assign a number of codes and text strings to a function key.

4 Select the Keys Visible check box to display the function keypad names (if any) in the keypad at the 
bottom of the Terminal window.

5 Click OK.
To execute the command of a function key, click the keypad name, or press CTRL+ALT and the function
key.

Related Procedures
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Assigning Codes and Text Strings to a Function Key
You can assign a number of codes and text strings to a function key. For example, you can assign a 
sequence that includes a number, a name, and a password to log on to a remote computer. A sample 
log-on command sequence might be:

^$C^$D03^M^$D02myname^M^$D04password^M
where myname represents your log-on name or user I.D., and password represents your password to 
the remote computer. These commands would perform the following actions in order:
1 Dial the number that you specified from the Settings menu (^$C).
2 Wait 3 seconds (^$DO3).
3 Send a carriage return (^M).
4 Wait 2 seconds (^$DO2).
5 Send your log-on name to the remote computer (myname).
6 Send a carriage return (^M).
7 Wait 4 seconds (^$DO4).
8 Send your password (password).
9 Send a carriage return (^M).
The delays are needed to give the remote computer enough time to respond with prompts. For example,
an online service would prompt you to enter your log-on name.



Assigning up to Four Functions to a Key
You assign key functions in sets--that is, one group of keys has one set of functions, a second group has
another set, and so on.

To specify sets of function keys:
1 Choose Function Keys from the Settings menu.
2 Select a number in the Key Level area.
3 Assign up to eight function key names and commands.
4 Repeat steps 2 and 3 to define other sets.
5 Press OK.

Related Procedures
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Showing and Hiding the Function Keypad
You can switch the function keypad at the bottom of the window on and off as you work.

To display or hide the function keypad:
Choose Show Function Keys from the Settings menu to display the keypad.

Or choose Hide Function Keys to hide the keypad.
Related Procedures
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Using the Function Keys You Assign
Once you assign function keys, you can use Terminal's function keypad with a mouse if the function 
keypad is showing.

To use the function keypad:
1 Turn on the function keypad.
2 Click the Level pad to select the level of function keys you want.
3 Click the name of the function key you want.
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Understanding Text and Binary Transfers
Before you send or receive files by using commands on the Transfers menu, you can specify the 
transfer rules. You should do so only if you plan to send or receive text or binary files. You need not do 
so if you are simply going to read or send electronic mail.
Text files are prepared with a text editor or word processing application and saved unformatted. This 
type of file is known as an ASCII file and contains only the printable ASCII characters and the few control
codes needed for minimal formatting, such as carriage returns and linefeeds. Font, style, and size 
specifications are stripped out. Because most applications can work with text alone, this format is useful 
for transfers between vastly different systems.
Binary files consist of ASCII characters plus the extended-ASCII character set. These files are not 
converted or translated during the transfer process.Unlike text transfers, which require you to know the 
settings needed by the remote computer, binary transfers allow you to use standard protocols for data 
transmission. You must specify the protocol that the remote computer uses. Terminal gives you the 
choice of two common protocols--XModem/CRC and Kermit. If you intend to transfer program files, you 
must use a binary transfer.
The two methods of transfer--text and binary--differ in a number of ways. In general, it is preferable to 
send both text and binary files using the binary transfer method because this method checks more 
rigorously for errors and loss of data. However, if you do not need to send formatting codes and you are 
not worried about the loss of data, the text transfer method can be faster. Some significant differences 
between binary and text transfers are summarized in the following:

Binary transfers Text transfers
Automatic retransmission. Possible suspension of transmission if an error is detected.
Suitable with any type of file. Suitable for use with ASCII text files only.
System type irrelevant. Lack of protocol makes system specifics important.
Parity not used for error-checking. Parity can be used to detect character transmission errors.
Transfer of entire file only. Transfer of entire or partial file.
When communicating with a system that does not recognize either of the binary protocols supported by 
Windows (XModem/CRC or Kermit), you will need to do a text transfer. Text transfers are intended for 
use with ASCII text files only.



Selecting Standard Flow Control for Text File Transfers
To select standard flow control:

In the Text Transfers dialog box, select Standard Flow Control.
The Flow Control Method is the one specified with the Communications command.

Related Procedures
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Transferring Text Files a Character at a Time
To transfer a character at a time:
1 In the Text Transfers dialog box, select Character at a Time.
2 Select Delay Between Characters or Wait for Character Echo.

Use this option To
Delay Between Characters Transmit evenly and slowly enough to prevent errors.

If you select this option, no true verification is done on the transmitted
data, and no feedback comes from the remote system.
In the text box, enter how many tenths of a second you want for the 
delay between characters.

Wait for Character Echo Send one character (eight bits) at a time and wait to echo the 
character back. Terminal then verifies that the two characters are the 
same before sending the next character. The transfer continues in 
this manner until the end of the file is reached.
This method is slow and should be used only with a system that 
echoes characters reliably.

Related Procedures
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Transferring Text Files a Line at a Time
To transfer a line at a time:
1 In the Text Transfers dialog box, select Line at a Time.
2 Specify Delay Between Lines or Wait for Prompt String.

Use this option To
Delay Between Lines Transfer evenly and slowly enough to prevent errors.

If you select this option, no true verification is done on the transmitted 
data, and no feedback comes from the remote system.
In the text box, enter how many tenths of a second you want for the delay 
between lines.

Wait for Prompt String Send one line and wait until the remote system sends a message string 
back to Terminal before sending the next line.
The remote system can assume that this session is occurring interactively 
and, therefore, sends back "OK, I'm ready for the next line" at the end of 
each line. This scenario assumes that you are waiting to see this string in 
the Terminal window before typing in the next line.
Terminal can also automate this process by allowing you to specify what 
string of characters it will wait for before sending the next line.
In the text box, enter an end-of-line code. M is the suggested end-of-line 
code, because if your remote system actually echoes characters instead 
of sending a prompt string, it will echo the carriage return (^M) at the end 
of a line. This code indicates that it received the whole line and is ready 
for the next.
This method is faster than character echo and works better if your remote 
character echo is unreliable. You can find this out by experimenting or by 
contacting the administrator of the remote system.

Related Procedures
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Setting Word Wrap for Text File Transfers
To set the word wrap for outgoing text:
1 In the Text Transfers dialog box, select the Word Wrap Outgoing Text at Column check box.
2 Type the number of columns you want.

Use this option if the files were created with a text editor or word processor. You can specify a column
up to 132 characters wide, regardless of the size of your terminal. If you don't select this option, 
outgoing text will be sent as it is currently formatted. To send a file to a 132-column terminal, enter 
131. Reducing the column size by one leaves one character space for the end-of-line code (usually 
^M).

Related Procedure
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Setting Up Binary Transfers
To set up a binary transfer:
1 Choose Binary Transfers from the Settings menu.
2 Select a protocol and click OK.

This protocol Uses
XModem/CRC All eight bits as data bits and thus requires the parity option to be set to None.

Terminal initially assumes the cyclic redundancy check (CRC) scheme for error 
checking. If the remote system doesn't support CRC, Terminal uses the checksum
scheme.

Kermit Either seven or eight bits as data bits. Thus, the parity option can be set to Even, 
Odd, or None. Use eight bits when sending information from the ASCII extended 
character set (from 128 to 255). Use None for eight data bit packets.

Related Procedure
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Connecting to the Remote Computer
Once you specify the settings for a session or open a Settings file, you can call the remote system. 
Terminal uses the phone number specified in the Phone Number option on the Settings menu or 
prompts you to supply the information.

To connect to the computer:
1 Choose Dial from the Phone menu.
2 Specify the phone number and options if you did not specify them with the Phone Number command. 

Then click OK.
Keyboard Procedure



Disconnecting from the Remote Computer
CAUTION: You should signal the remote computer with an exit command before choosing Hangup. If 
you choose Hangup first, you will be disconnected from the remote computer, but its phone connection 
will remain off the hook. Your account might continue to be charged for connect time until the remote 
system detects that the connection has been dropped.

To disconnect from the computer:
1 Type the remote computer's exit command.

This command hangs up the remote modem.
2 Choose Hangup from the Phone menu.
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Sending Text Files
If you specified the settings for text transfers, you can send your file. You can use the Send Text File 
command on the Transfers menu to send files you have saved in ASCII format (with minimal formatting 
codes).

To send text files:
1 Choose Send Text File from the Transfers menu.
2 If the file is in the current directory, select the name of the file in the Files box.

If the file is not in the current directory, select the directory you want in the Directories box. Then 
select the name of the file in the Files box.    

3 Select Append LF to attach a linefeed to the end of each line of text you send.
Or select Strip LF to strip out linefeeds.
You should strip linefeeds if the remote system adds them to incoming text.

4 Click OK to begin sending the file.
You will see the file scroll in the Terminal window.

5 Choose a Transfers menu command or click a button at the bottom of the Terminal window to pause, 
resume, or stop the transfer.

Related Procedures
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hint
The current directory is shown below the Filename box. Double-clicking the two periods [..] at the top of 
the Directories box shows the files and directories located one level closer to a disk's root directory.
Instead of using the Files and Directories list boxes to select a file, you can type the complete pathname 
in the Filename box.



Sending Binary Files
To send a binary file:
1 Tell the host computer to prepare to receive a binary file, and indicate the type of protocol to use.

The binary file is sent according to the protocol specified with the Binary Transfers command.
2 Choose Send Binary File from the Transfers menu.
3 If the file is in the current directory, double-click the name of the file in the Files box.

If the file is not in the current directory, double-click the directory you want in the Directories box. Then
select the name of the file in the Files box.    
The file transfer begins, and the bottom of the window displays the name of the file being sent.

4 Click the Stop button to terminate the file transfer.
Or choose Stop from the Transfers menu.
You cannot pause or resume a binary file transfer.
If Terminal is running as an icon during a binary transfer, the icon will flash when the transfer is either 
completed or fails. Restore Terminal to a window to continue your communications session.

Related Procedures
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Receiving New Text Files
If you specified the settings for text transfers, you can receive a new text file.

To receive a new text file:
1 Choose Receive Text File from the Transfers menu.
2 If you want to receive the file in the current directory, type the filename, including a filename extension

if you want to specify one.
The .TXT extension is automatically assigned to the filename if you don't specify an extension. If you 
specify an extension, it overrides any automatic extension.
If you want to receive the file in a different directory, double-click its name in the Directories box. Then
type the filename.    

3 Select Save Controls if appropirate.
4 Select Table Format if appropriate.
5 Click OK.    
6 Choose a Transfers menu command or click a button at the bottom of the Terminal window to pause, 

resume, or stop the transfer.
Related Procedures
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hint
Instead of using the Files and Directories list boxes to receive a file, you can type the complete 
pathname in the Filename box and click OK.



Overwriting Incoming Information to Existing Text Files
If you specified the settings for text transfers, you can overwrite an existing text file.

To overwrite a file:
1 Choose Receive Text File from the Transfers menu.
2 If you want to overwrite a file in the current directory, type the filename, including the filename 

extension.
If you want to overwrite a file in a different directory, double-click its name in the Directories box. Then
type the filename.    

3 Select Save Controls if appropirate.
4 Select Table Format if appropriate.
5 Click OK.    
6 Choose Yes to confirm you want to replace the existing file.
7 Choose a Transfers menu command or click a button at the bottom of the Terminal window to pause, 

resume, or stop the transfer.
Related Procedures
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hint
Instead of using the Files and Directories list boxes to overwrite a file, you can type the complete 
pathname in the Filename box and click OK.



Appending Incoming Information to Existing Text Files
If you specified the settings for text transfers, you can append all incoming information to the end of a 
specified file.

To append a file:
1 Choose Receive Text File from the Transfers menu.
2 Select the Append File check box.
3 If you want to append a file in the current directory, type the filename, including the filename 

extension.
If you want to append a file in a different directory, double-click its name in the Directories box. Then 
type the filename.    

4 Select Save Controls if appropirate.
5 Select Table Format if appropriate.
6 Click OK.    
7 Choose a Transfers menu command or click a button at the bottom of the Terminal window to pause, 

resume, or stop the transfer.
Related Procedures
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hint
Instead of using the Files and Directories list boxes to append a file, you can type the complete 
pathname in the Filename box and click OK.



Receiving Incoming Text Files in Tabular Format
To receive incoming text in tabular format:

In the Receive Text File dialog box, select the Table Format check box.
Terminal will put tab characters between incoming text separated by two or more consecutive spaces.

Related Procedure
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Saving Control Codes in Incoming Text Files
To save some of the formatting codes:

In the Receive Text File dialog box, select the Save Controls check box.
Many applications, such as word processing or spreadsheet programs, allow you (or the sender) to 
save files as text. This means most of the formatting codes are stripped out of the file and it can be 
sent as a text file. However, the file may retain some formatting codes rather than be saved in pure 
ASCII form. If you select this option, those formatting codes will be received by your system.

Related Procedure
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Receiving Binary Files
To receive a binary file:
1 Tell the host computer to send a binary file, and indicate the type of protocol to use.

Terminal receives a file in binary file format according to the protocol specified with the Binary 
Transfers command.

2 Choose Receive Binary File from the Transfers menu.
3 If you want to receive the file in the current directory, type the filename, including a filename extension

if you want to specify one.
If you want to receive the file in a different directory, double-click its name in the Directories box. Then
type the filename.    

4 Click OK.    
If you selected an existing file, click OK to confirm that you want to overwrite the file.
The transfer begins, and the bottom of the window displays the name of the file being sent.
Occasionally, a communications error prevents the successful transfer of data. When this occurs, the 
remote system will try again. When the maximum number of retries has been reached, Terminal 
cancels the file transfer. The Retries box at the bottom of the Terminal window displays the number of 
times the remote system has tried to send the data. The maximum number of retries for the 
XModem/CRC protocol is 20. The maximum number of retries for the Kermit protocol is 5.

5 Click the Stop button to terminate the file transfer.
Or choose Stop from the Transfers menu.
You cannot pause or resume a binary file transfer.
If Terminal is running as an icon during a binary transfer, the icon will flash when the transfer is either 
completed or fails. Restore Terminal to a window to continue your communications session.

Related Procedures
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Viewing Text Files
You can view a file in the Terminal window before sending it or after it has been received from the 
remote system.

To view a text file:
1 Choose View Text File from the Transfers menu.
2 If the file is in the current directory, select the name of the file in the Files box.

If the file is not in the current directory, select the directory you want in the Directories box. Then 
select the name of the file in the Files box.    

3 Select Append LF to show the file with linefeeds.
Or select Strip LF to show the file without linefeeds.
If you already specified linefeeds when you received a file, you might want to ignore these options.

4 Click OK.
5 Choose a Transfers menu command or click a button at the bottom of the Terminal window to control 

the display of the file.
Related Procedures
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Pausing, Resuming, and Stopping Transfers
You can pause, resume, and stop text transfers; however, you can only stop binary transfers.

To pause, resume, or stop transfers:
Choose Pause, Resume, or Stop from the Transfers menu.

Or click the appropriate button at the bottom of the Terminal window.
You can also use the Pause, Resume, and Stop commands and buttons when you view a text file.
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Selecting Text
To select text:
1 Point to the first character you want to select.
2 Press the mouse button and drag the pointer to the last character you want to select.
3 Release the mouse button.

The selected text is highlighted.

To cancel a selection:
Click again anywhere in the document to cancel the selection.
Related Procedure
Keyboard Procedure



Selecting All Text
To select all the text in the Terminal window and scroll buffer:

Choose Select All from the Edit menu.
Related Procedures
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Sending Selected Text to the Remote Computer
To send text:
1 Select the text.
2 Choose Send from the Edit menu.

When you choose Send, the text is copied onto the Clipboard and then sent to the remote computer.
Related Procedures
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Copying Text onto the Clipboard
To copy text onto the Clipboard:
1 Select the text.
2 Choose Copy from the Edit menu.

Once you copy text onto the Clipboard, you can send it to a remote computer or paste it into another 
application.

Related Procedures
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Sending the Clipboard Contents
When you paste text from the Clipboard, Terminal sends a copy of the Clipboard contents to the remote 
system. The contents of the Clipboard remain unchanged.

To send the Clipboard contents to the remote computer:
Choose Paste from the Edit menu.
Related Procedures
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Clearing the Buffer
In some communications applications, text you type beyond a full screen is lost. Terminal, however, 
displays scroll bars on the window when you type more than a screen of information and puts text that 
does not appear on the screen into a buffer. This way, you can scroll forward and backward to see text 
you already typed or received. At times, you might want to clear the buffer to free up memory.

To clear the contents of the scroll buffer and window:
Choose Clear Buffer from the Edit menu.
Related Procedures
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Printing Incoming Text
The Printer Echo command turns printing mode on and off. When Printer Echo is on, all information 
received by Terminal is echoed to the printer. If you plan to print incoming text during the current 
communications session, choose this command before you receive information.
Information is printed only if you have connected and installed a printer. Information is automatically 
printed on the default printer.

To print incoming text:
1 Choose Printer Echo from the Settings menu before you receive incoming text.
2 Receive the text file.

Incoming text is sent to the Terminal printer. If Local Echo is turned on, your keystrokes are also sent 
to the printer.

3 Choose Printer Echo again to turn printer mode off and eject from the printer any text less than a 
page long.

Related Procedures
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Printing Selected Text
The best time to print selected text in the Terminal window or scroll buffer is when you are ready to end 
the communications session.

To print text you already received or entered:
1 Select the text you want to print.

If you want to select the entire contents of the scroll buffer,choose Select All from the Edit menu.
2 Choose Copy from the Edit menu to place the selected text onto the Clipboard.
3 End the Terminal session by choosing Exit from the File menu.
4 Start a word processor or text editor.
5 Paste the contents of the Clipboard into a text file using the word processor or text editor.
6 Print the text file.

Related Procedure
Keyboard Procedure



Changing Printers and Printer Options
If you have several printers connected to your computer and designated as active printers, you can print 
to one of these printers by selecting it as the default printer.

To change printers:
1 Choose Printer Setup from the File menu.
2 Select the printer that you want to print on.
3 Choose Setup to change printer options.

In the dialog box that appears, the available options depend on the printer you choose.
4 Select the options you want.

For more information on the options, click the Help button in the printer's Setup dialog box.
5 Click OK to close the printer's Setup dialog box.
6 Click OK.

Related Procedure
Keyboard Procedure



Creating New Files
To create a new file:

Choose New from the File menu.
Related Procedure
Keyboard Procedure



Opening Existing Files
To open a file:
1 Choose Open from the File menu.
2 If the file is in the current directory, double-click the name of the file in the Files box.

If the file is not in the current directory, double-click the directory you want in the Directories box. Then
double-click the name of the file in the Files box.    

Related Procedures
Keyboard Procedure



Procedures
Browsing Through the Directories List Box
Creating New Files



hint
The current directory is shown below the Filename box. Double-clicking the two periods [..] at the top of 
the Directories box shows the files and directories located one level closer to a disk's root directory.
Instead of using the Files and Directories list boxes to open a file, you can type the complete pathname 
in the Filename box and click OK.



Saving Existing Files
Use the Save command to save changes to an existing file.

To save an existing file:
Choose Save from the File menu.
Related Procedure
Keyboard Procedure



Saving New or Renaming Existing Files
To save a new file or to save an existing file under a different name:
1 Choose Save As from the File menu.
2 If you want to save the file in the current directory, type the filename, including a filename extension if 

you want to specify one.
The .TRM extension is automatically assigned to the filename if you don't specify an extension. If you 
specify an extension, it overrides any automatic extension.
If you want to save the file in a different directory, double-click its name in the Directories box. Then 
type the filename.    
If you name your file TERMINAL.TRM, Terminal will automatically open this file next time you start 
Terminal from File Manager or Program Manager.

3 Click OK.    
Related Procedure
Keyboard Procedure



hint
The current directory is shown below the Filename box. Double-clicking the two periods [..] at the top of 
the Directories box shows the directories located one level closer to a disk's root directory.



hint
Instead of using the Files and Directories list boxes to save a file, you can type the complete pathname 
in the Filename box and click OK.





To Press

Copy the selection onto the Clipboard CTRL+INS

Send the Clipboard contents to the 
remote system

SHIFT+INS

Send the selected text to the remote 
system

CTRL+SHIFT+INS

Execute one of 32 user-defined 
commands

CTRL+ALT+(F1 through F8)

Related Procedure
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Keyboard: Specifying the Phone Number
To specify the phone number that Terminal will dial:
1 Press ALT and then S.
2 Press N.
3 Type the phone number in the Dial text box.
4 Press TAB and type the number of seconds you want for the Timeout If Not Connected In option.
5 Press TAB and then press the SPACEBAR to select or clear the Redial After Timing Out option.
6 Press TAB and then press the SPACEBAR to select or clear the Signal When Connected option.
7 Press ENTER.

Mouse Procedure



Keyboard: Setting Terminal Emulation
To set the terminal emulation type:
1 Press ALT and then S.
2 Press T.
3 Use the UP ARROW or DOWN ARROW key to select a terminal type.
4 Press ENTER.

Mouse Procedure



Keyboard: Specifying Communications Parameters
To specify communications parameters:
1 Press ALT and then S.
2 Press C.
3 Press ALT+the underlined letter associated with an option you want to change.
4 Use the arrow keys to select the setting you want if the option has option buttons or a list box.
5 Press ENTER.

Mouse Procedure



Keyboard: Specifying Modem Commands
To specify modem commands:
1 Press ALT and then S.
2 Press D.
3 Press ALT+M.
4 Use the UP ARROW or DOWN ARROW key to select a modem type.
5 Press TAB until you select an option you want to change.
6 Type the modem command.
7 Press ENTER.

Mouse Procedure



Keyboard: Timing Terminal Sessions
To time your sessions:
1 Make sure the function keypad is visible.
2 Choose Timer Mode (press ALT and then S, and then press I).
3 Choose Timer Mode again to reset the timer.

Mouse Procedure



Keyboard: Specifying Terminal Modes
To specify terminal modes:
1 In the Terminal Preferences dialog box, press ALT+W to select Line Wrap.
2 Press ALT+E to select Local Echo.
3 Press ALT+S until you select the Sound option and then press the SPACEBAR to select the option.

Mouse Procedure



Keyboard: Specifying Carriage Returns and Linefeeds (CR to CR/LF)
To cause a carriage return to be interpreted as a carriage return plus a linefeed:
1 In the Terminal Preferences dialog box, press ALT+I to select Inbound.
2 Press ALT+O to select Outbound.

Mouse Procedure



Keyboard: Specifying Columns for Your Monitor
To specify columns:

In the Terminal Preferences dialog box, press ALT+8 to select 80 or press ALT+1 to select 132.
Mouse Procedure



Keyboard: Specifying the Type of Cursor
To specify how the cursor will appear:
1 In the Terminal Preferences dialog box, press ALT+B to select Block or press ALT+U to select Underline.
2 Press ALT+K to select Blink if you want a blinking cursor.

Mouse Procedure



Keyboard: Selecting Fonts
To select a font:
1 In the Terminal Preferences dialog box, press ALT+F.
2 Use the UP ARROW or DOWN ARROW key to select one of the fonts from the Terminal Font box.
3 Press TAB and use the UP ARROW or DOWN ARROW to select one of the font sizes for the font you 

choose.
Mouse Procedure



Keyboard: Selecting a Different Language
To select a different language:
1 In the Terminal Preferences dialog box, press ALT+T.
2 Use the UP ARROW or DOWN ARROW key to select a setting from the Translation box.

Mouse Procedure



Keyboard: Showing the Scroll Bars
To show the scroll bars:
1 In the Terminal Preferences dialog box, press ALT+S until you select Show Scroll Bars.
2 Press the SPACEBAR to select the Show Scroll Bars check box.

Related Procedure
Mouse Procedure



Keyboard: Setting the Buffer Size
To set how many lines of information can be saved in the buffer:
1 In the Terminal Preferences dialog box, press ALT+L.
2 Type a number between 25 and 400 in the Buffer Lines text box.

Related Procedurde
Mouse Procedure



Keyboard: Assigning Function Keys and Their Commands
To assign function keys:
1 Press ALT and then S.
2 Press K and then ENTER.
3 Press TAB until the insertion point reaches the box for a function key you want to assign.
4 Type a name if you want to assign a name to the key.
5 Press TAB and type text and/or codes to define the function key.

Control code Function
^A to ^Z Sends control code A to Z to the remote computer.
^$D<NN> Causes Terminal to delay <NN> seconds before continuing.
^$B Causes Terminal to transmit a break code of 117 milliseconds in duration.
^$C Chooses Dial from the Phone menu.
^$H Chooses Hangup from the Phone menu.
^$L1 to ^$L4 Changes to another level of key groups in which keys are defined.
You can assign a number of codes and text strings to a function key.

6 Press ALT+V if you want to select Keys Visible.
7 Press ENTER.

Related Procedures
Mouse Procedure



Procedures
Assigning up to Four Functions to a Key
Showing and Hiding the Function Keypad
Using the Function Keys You Assign



Keyboard: Assigning up to Four Functions to a Key
To specify sets of function keys:
1 Press ALT and then S.
2 Press K and then ENTER.
3 Press ALT+L.
4 Use the arrow keys to select a number in the Key Level area.
5 Assign up to eight function-key names and commands.
6 Repeat steps 3 through 5 to define other sets.
7 Press ENTER.

Related Procedures
Mouse Procedure



Procedures
Assigning Function Keys and Their Commands
Showing and Hiding the Function Keypad
Using the Function Keys You Assign



Keyboard: Showing and Hiding the Function Keypad
To display or hide the function keypad at the bottom of the Terminal window:
1 Press ALT and then S.
2 Press K until you select Show Function Keys or Hide Function Keys.
3 Press ENTER.

Related Procedures
Mouse Procedure



Procedures
Assigning Function Keys and Their Commands
Timing Terminal Sessions
Using the Function Keys You Assign



Keyboard: Using the Function Keys You Assign
To use function keys:
1 Press ALT and then S. Then press K, ENTER, ALT+L, use the arrow keys to select a level, and press 

ENTER.
Or skip this step to use the current level of function keys.

2 Press CTRL+ALT and the function key you want.
Related Procedures
Mouse Procedure



Procedures
Assigning Function Keys and Their Commands
Showing and Hiding the Function Keypad



Keyboard: Selecting Standard Flow Control for Text File Transfers
To select standard flow control:

In the Text Transfers dialog box, press ALT+S to select Standard Flow Control.
Related Procedures
Mouse Procedure



Procedures
Transferring Text Files a Character at a Time
Transferring Text Files a Line at a Time
Understanding Text and Binary Transfers



Keyboard: Transferring Text Files a Character at a Time
To transfer a character at a time:
1 In the Text Transfers dialog box, press ALT+C to select Character at a Time.
2 Press ALT+D to select Delay Between Characters. Then press TAB and type the number of tenths of a 

second you want for the delay.
Or press ALT+E to select Wait for Character Echo.

Related Procedures
Mouse Procedure



Procedures
Selecting Standard Flow Control for Text File Transfers
Transferring Text Files a Line at a Time
Understanding Text and Binary Transfers



Keyboard: Transferring Text Files a Line at a Time
To transfer a line at a time:
1 In the Text Transfers dialog box, press ALT+L to select Line at a Time.
2 Press ALT+B to select Delay Between Lines. Then press TAB and type the number of tenths of a 

second you want for the delay.
Or press ALT+P to select Wait for Prompt String. Then press TAB and type an end-of-line code.

Related Procedures
Mouse Procedure



Procedures
Selecting Standard Flow Control for Text File Transfers
Transferring Text Files a Character at a Time
Understanding Text and Binary Transfers



Keyboard: Setting Word Wrap for Text File Transfers
To set the word wrap for outgoing text:
1 In the Text Transfers dialog box, press ALT+W to select the Word Wrap Outgoing Text at Column check

box.
2 Type the number of columns you want.

Related Procedure
Mouse Procedure



Keyboard: Setting Up Binary Transfers
To set up a binary transfer:
1 Press ALT and then S.
2 Press B.
3 Use the UP ARROW or DOWN ARROW key to select XModem/CRC or Kermit.
4 Press ENTER.

Related Procedure
Mouse Procedure



Keyboard: Connecting to the Remote Computer
To connect to the computer:
1 Press ALT and then P.
2 Press D.

Mouse Procedure



Keyboard: Disconnecting from the Remote Computer
To disconnect from the computer:
1 Type the remote computer's exit command.
2 Press ALT and then P.
3 Press H.

Mouse Procedure



Keyboard: Sending Text Files
To send text files:
1 Press ALT and then T.
2 Press S.
3 If the file is in the current directory, press ALT+F and use the UP ARROW or DOWN ARROW key to select 

the file.
If the file is not in the current directory,press ALT+D, use the UP ARROW or DOWN ARROW key to select a 
drive or directory, and press ENTER. Then press ALT+F and use the UP ARROW or DOWN ARROW key to 
select the file.    

4 Press ALT+A to attach a linefeed to the end of each line of text you send.
Or press ALT+S to strip out linefeeds.

5 Press ENTER to begin sending the file.    
6 Choose a Transfers menu command to pause, resume, or stop the transfer.

Related Procedures
Mouse Procedure



Procedures
Browsing Through the Directories List Box
Specifying Carriage Returns and Linefeeds (CR to CR/LF)
Understanding Text and Binary Transfers



Keyboard: Sending Binary Files
To send a binary file:
1 Tell the host computer to prepare to receive a binary file, and indicate the type of protocol to use.
2 Press ALT and then T.
3 Press B.
4 If the file is in the current directory, press ALT+F and use the UP ARROW or DOWN ARROW key to select 

the file.
If the file is not in the current directory,press ALT+D, use the UP ARROW or DOWN ARROW key to select a 
drive or directory, and press ENTER. Then press ALT+F and use the UP ARROW or DOWN ARROW key to 
select the file.    

5 Press ENTER.    
6 Press ALT+F and use the UP ARROW or DOWN ARROW to select the file.
7 Press ALT and then T, and then press O to terminate the file transfer.

Related Procedures
Mouse Procedure



Procedures
Browsing Through the Directories List Box
Understanding Text and Binary Transfers



hint
Instead of using the Files and Directories list boxes to send a file, you can type the complete pathname 
in the Filename box and press ENTER.



Keyboard: Receiving New Text Files
To receive a new text file:
1 Press ALT and then T.
2 Press R.
3 If you want to receive the file in the current directory, type the filename, including a filename extension

if you want to specify one.
If you want to receive the file in a different directory, press ALT+D and use the UP ARROW or DOWN 
ARROW key to select a directory, and press ENTER. Then press ALT+N and type the filename.    

4 Select Save Controls to save control codes.
5 Select Table Format to receive the file in tabular format.
6 Press ENTER.    
7 Choose a Transfers menu command to pause, resume, or stop the transfer.

Related Procedures
Mouse Procedure



Procedures
Browsing Through the Directories List Box
Receiving Incoming Text Files in Tabular Format
Saving Control Codes in Incoming Text Files
Understanding Text and Binary Transfers



hint
Instead of using the Files and Directories list boxes to receive a file, you can type the complete 
pathname in the Filename box and press ENTER.



Keyboard: Overwriting Incoming Information to Existing Text Files
To overwrite a file:
1 Press ALT and then T.
2 Press R.
3 If you want to overwrite the file in the current directory, type the filename, including a filename 

extension if you want to specify one.
If you want to overwrite the file in a different directory, press ALT+D and use the UP ARROW or DOWN 
ARROW key to select a directory, and press ENTER. Then press ALT+N and type the filename.    

4 Select Save Controls to save control codes.
5 Select Table Format to receive the file in tabular format.
6 Press ENTER.    
7 Press ENTER to confirm that you want to replace the existing file.
8 Choose a Transfers menu command to pause, resume, or stop the transfer.

Related Procedures
Mouse Procedure



Procedures
Browsing Through the Directories List Box
Understanding Text and Binary Transfers



hint
Instead of using the Files and Directories list boxes to overwrite a file, you can type the complete 
pathname in the Filename box and press ENTER.



Keyboard: Appending Incoming Information to Existing Text Files
To append a file:
1 Press ALT and then T.
2 Press R.
3 Press ALT+A.
4 If you want to append the file in the current directory, type the filename, including a filename 

extension if you want to specify one.
If you want to append the file in a different directory, press ALT+D and use the UP ARROW or DOWN 
ARROW key to select a directory, and press ENTER. Then press ALT+N and type the filename.    

5 Select Save Controls to save control codes.
6 Select Table Format to receive the file in tabular format.
7 Press ENTER.    
8 Choose a Transfers menu command to pause, resume, or stop the transfer.

Related Procedures
Mouse Procedure



Procedures
Browsing Through the Directories List Box
Understanding Text and Binary Transfers



hint
Instead of using the Files and Directories list boxes to append a file, you can type the complete 
pathname in the Filename box and press ENTER.



Keyboard: Receiving Incoming Text Files in Tabular Format
To receive incoming text in tabular format:

In the Receive Text File dialog box, press ALT+T.
Related Procedure
Mouse Procedure



Keyboard: Saving Control Codes in Incoming Text Files
To save control codes:

In the Receive Text File dialog box, press ALT+C.
Related Procedure
Mouse Procedure



Keyboard: Receiving Binary Files
To receive a binary file:
1 Tell the host computer to send a binary file, and indicate the type of protocol to use.
2 Press ALT and then T.
3 Press F.
4 If you want to receive the file in the current directory, type the filename, including a filename extension

if you want to specify one.
If you want to receive the file in a different directory, press ALT+D and use the UP ARROW or DOWN 
ARROW key to select a directory, and press ENTER. Then press ALT+N and type the filename.    

5 Press ENTER.    
6 Press ALT and then T, and then press O to terminate the file transfer.

Related Procedure
Mouse Procedure



Keyboard: Viewing Text Files
To view a text file:
1 Press ALT and then T.
2 Press V.
3 If the file is in the current directory, press ALT+F and use the UP ARROW or DOWN ARROW key to select 

the file.
If the file is not in the current directory,press ALT+D, use the UP ARROW or DOWN ARROW key to select a 
drive or directory, and press ENTER. Then press ALT+F and use the UP ARROW or DOWN ARROW key to 
select the file.    

4 Press ALT+A to show the file with linefeeds.
Or press ALT+S to show the file without linefeeds.

5 Press ENTER to begin viewing the file.    
6 Choose a Transfers menu command to control the display of the file.

Related Procedures
Mouse Procedure



Procedures
Browsing Through the Directories List Box
Specifying Carriage Returns and Linefeeds (CR to CR/LF)
Understanding Text and Binary Transfers



Keyboard: Pausing, Resuming, and Stopping Transfers
To pause, resume, or stop transfers:
1 Press ALT and then T.
2 Press P (Pause), E (Resume), or O (Stop).

Mouse Procedure



Keyboard: Selecting Text
To select text:
1 Press the ARROW keys to move the insertion point to the first character you want to select.
2 Press SHIFT.
3 Press the arrow keys to move the insertion point to the last character you want to select.
4 Release SHIFT.

To cancel a selection:
Press an arrow key.
Related Procedure
Mouse Procedure



Keyboard: Selecting All Text
To select all the text in the Terminal window and scroll buffer:
1 Press ALT and then E.
2 Press A.

Related Procedures
Mouse Procedure



Procedures
Copying Text onto the Clipboard
Sending the Clipboard Contents
Sending Selected Text to the Remote Computer



Keyboard: Sending Selected Text to the Remote Computer
To send text:
1 Select the text.
2 Press CTRL+SHIFT+INS.

Related Procedures
Mouse Procedure



Procedures
Copying Text onto the Clipboard
Selecting All Text
Sending the Clipboard Contents



Keyboard: Copying Text onto the Clipboard
To copy text onto Clipboard:
1 Select the text.
2 Press CTRL+INS.

Related Procedures
Mouse Procedure



Procedures
Selecting All Text
Sending Selected Text to the Remote Computer



Keyboard: Sending the Clipboard Contents
To send the Clipboard contents to the remote computer:

Press SHIFT+INS.
Related Procedures
Mouse Procedure



Procedures
Copying Text onto the Clipboard
Selecting All Text
Sending Selected Text to the Remote Computer



Keyboard: Clearing the Buffer
To clear the contents of the scroll buffer and window:
1 Press ALT and then E.
2 Press E.

Related Procedures
Mouse Procedure



Procedures
Setting the Buffer Size
Showing the Scroll Bars



Keyboard: Printing Incoming Text
To print incoming text:
1 Choose Printer Echo (press ALT and then S, and then press E) before you receive incoming text.
2 Receive the text file.
3 Choose Printer Echo again to turn printer mode off and eject from the printer any text less than a 

page long.
Related Procedure
Mouse Procedure



Keyboard: Printing Selected Text
To print text you already received or entered:
1 Select the text you want to print.
2 Press CTRL+INS to place the selected text onto the Clipboard.
3 End the Terminal session by pressing ALT and then F, and then pressing X.
4 Start a word processor or text editor.
5 Paste the contents of the Clipboard into a text file using the text editor or word processor.
6 Print the text file.

Mouse Procedure



Keyboard: Changing Printers and Printer Options
To change printers or printer options:
1 Press ALT and then F.
2 Press R.
3 Use the UP ARROW or DOWN ARROW to select the printer that you want.
4 Press ALT+S to change printer options.
5 Select the options you want and press ENTER.
6 Press ENTER.

Mouse Procedure



Keyboard: Creating New Files
To create a new file:
1 Press ALT and then F.
2 Press N.

Related Procedure
Mouse Procedure



Keyboard: Opening Existing Files
To open a file:
1 Press ALT and then F.
2 Press O.
3 If the file is in the current directory, press ALT+F and use the UP ARROW or DOWN ARROW key to select 

the file.
If the file is not in the current directory,press ALT+D, use the UP ARROW or DOWN ARROW key to select a 
drive or directory, and press ENTER. Then press ALT+F and use the UP ARROW or DOWN ARROW key to 
select the file.    

4 Press ENTER.    
Related Procedure
Mouse Procedure



hint
The current directory is shown below the Filename box. Choosing the two periods [..] at the top of the 
Directories box shows the files and directories located one level closer to a disk's root directory.



hint
Instead of using the Files and Directories list boxes to open a file, you can type the complete pathname 
in the Filename box and press ENTER.



Keyboard: Saving Existing Files
Use the Save command to save changes to an existing file.

To save an existing file:
1 Press ALT and then F.
2 Press S.

Related Procedure
Mouse Procedure



Keyboard: Saving New or Renaming Existing Files
To save a new file or to save an existing file under a different name:
1 Press ALT and then F.
2 Press A.
3 If you want to save the file in the current directory, type the filename, including a filename extension if 

you want to specify one.
If you want to save the file in a different directory, press ALT+D and use the UP ARROW or DOWN ARROW 
key to select a directory, and press ENTER. Then press ALT+N and type the filename.    

4 Press ENTER.    
Related Procedure
Mouse Procedure



hint
The current directory is shown below the Filename box. Choosing the two periods [..] at the top of the 
Directories box shows the directories located one level closer to a disk's root directory.



hint
Instead of using the Files and Directories list boxes to save a file, you can type the complete pathname 
in the Filename box and press ENTER.







status bar          
Shows status information when you view or transfer a file.
Depending on the type of file or tranfer, the status bar might show:

Stop, Pause, and Resume buttons.
A ruler indicating how much of the file has been received, sent, or shown.
The filename.



Terminal
The Windows communications application. With Terminal, you can connect your computer to other 
computers and exchange information. For example, you can use Terminal to hook up to an online news 
service or to online bulletin boards.



application Control-menu



title bar          
Contains the title of the application running in the window, in this case Terminal.

Drag the title bar to move the window.



Minimize button          
Click the Minimize button to shrink the Terminal window to an icon.



Maximize button          
Click the Maximize button to enlarge the Terminal window to its maximum size.



File Menu



Edit Menu



Settings Menu



Phone Menu



Transfers Menu



Help Menu



menu bar          
Contains the names of all the Terminal menus.

Click a menu name to display commands.



scroll arrow          

An arrow on either end of a scroll bar used to move the contents of the window or list box into view.
Click a scroll arrow to move the contents into view.



scroll bar          
A bar that appears at the right and/or bottom edge of a window whose contents aren't completely visible.
Each scroll bar contains two scroll arrows and a scroll box for moving the contents of the window or list 
box.
In Terminal, you can turn scroll bars on or off.

Click a scroll bar to move the contents one screen.



scroll box          

A box used to move quickly to a particular location in a file or list.
Drag the scroll box to move to another location.



Terminal cursor          
Indicates where text will appear. The cursor appears blinking, block, or underlined, depending the 
options you specify.
Text appears in the window when you view, send, and receive information.



text
Appears in the Terminal window when you view, send, and receive information.

Select text by dragging the pointer across it.



function keypad          

Enters text you assign or executes communications commands.
You can assign text such as a password or control codes to each key in the keypad.

Click the key in the keypad to choose a function.



level key          

Switches to the next level of keys you've assigned in your function keypad. You can specify up to four 
levels of keys.

Click the level key to see a different set of keys in your function keypad.



time key          

Shows the time or the timer.
Use the timer to show how long your communications session is lasting.

Click the time key to switch between the time and the timer.



application window
The main window for an application, in this case the Terminal window. The Terminal application window 
contains text you are viewing, sending, or receiving.



window border          
The outside edge of a window.

Drag the window border to change the size of the window.







A
386 enhanced mode
active
active printer
animation
application
application icon
application window
arrow keys
associate
AUTOEXEC.BAT



B
<< button
>> button
Back button
base-level synthesizer
batch file
baud rate
bitmap
branch
browse
byte



C
cascading menu complementary color
CD-ROM compound device
channel CONFIG.SYS
check box Contents button
choose Control menu
Clipboard Control-menu box
close conventional memory
collapse cutout
command
command button
command line



D
data bits Directory Tree window
default button directory window
default printer disk-drive icon
desktop display box
desktop pattern document
destination directory document file
device contention document window
device driver DOS
dialog box drag
directory path drop-down list box
Directory Tree



E
error-checking
expand
expanded memory
extended memory
extended synthesizer
extension



F
file
file information line
flow control
font
font size
format
full-screen application



G
General MIDI Mode standard
group
group icon
group window



H
History button
hotspot
hue
HyperGuide button bar



I
icon
insertion point
International MIDI Association



J
No defined terms.



K
keymaps
keyword
kilobyte



L
list box
local printer
local queue
luminosity



M
maximize MIDI Mapper
Maximize button MIDI sequencer
Media Control Interface MIDI Manufacturer's Association (MMA)
memory minimize
menu Minimize button
menu bar movie file
menu command MSCDEX
menu name multimedia extensions
menu title Multimedia PC
MIDI multitasking
MIDI file



N
network printer
network queue
network server
non-Windows application



O
open
option button



P
parity print option
palette printer-driver file
patch printer font
patchmaps printer queue information line
pathname program file
picture elements program information file (PIF)
pixels program item
playlist program item icon
pointer
port



Q
No defined terms.



R
RGB components
read-only
real mode
Restore button
root directory



S
sample serial port
saturation shortcut key
scaled font size shrink
screen font simple device
screen saver solid color
scroll arrow source directory
scroll bar spin box
scroll box standard mode
Search button status bar
select stop bits
selection cursor synthesizer



T
Task List
text box
text file
title
title bar
topic
track



U
Up button



V
vector font
virtual memory
volume label



W
waveform
WAVE format
wildcard characters
window
window border
Windows application
wrap



X
No defined terms.



Y
No defined terms.



Z
No defined terms.



386 enhanced mode
Provides access to the virtual memory capabilities of the Intel 80386 processor. With virtual memory 
capabilities, Windows applications can use more memory than is physically available. Enhanced mode 
also allows for multitasking of non-Windows applications.



active
Describes the selected window or icon that you are currently working with. Windows always applies the 
next keystroke or command you choose to the active window. If a window is active, it appears in front of 
all other windows on the desktop, and its title bar changes color to differentiate it visually from other 
windows. If an icon is made active, its Control menu appears.
Inactive is the opposite of active and describes windows or icons on the desktop that are not selected.



active printer
An installed printer that has been assigned to a printer port using Setup or Control Panel. More than one
printer can be set up to work on a single port, but only one can be active, since only one printer can be 
physically connected to the port at a time.
An inactive printer is an installed printer that is not currently connected to the printer port.



animation
The display of a series of graphic images, simulating motion. You can play animation files (for example, 
files with the.MMM extension) with the Media Player accessory. Animations are also called movies.



application
A computer program used for a particular kind of work, such as word processing. This term is often used
interchangeably with "program."



application icon          

An icon that represents an application that is running.



application window
The main window for an application. It contains the application's menu bar and main workspace. An 
application window may contain multiple document windows.



arrow keys          

The four arrow keys on your computer keyboard. These keys move the cursor or pointer on your screen 
to locations you choose. Each arrow key moves the cursor or pointer in the direction of the arrow on the 
key. Each arrow key is named for the direction in which arrow points: UP ARROW, DOWN ARROW, LEFT 
ARROW, and RIGHT ARROW.



associate
To assign files that have the same extension to a program. When you choose a file with the specified 
extension, the associated application runs with the file loaded.



AUTOEXEC.BAT
Batch file that lists MS-DOS commands. MS-DOS automatically carries out the commands in your 
AUTOEXEC.BAT file when you turn on your computer. The file is located in the root directory of your first
hard disk, which is usually drive C.
Typically, an AUTOEXEC.BAT file starts memory-resident utilities such as a network and sets up 
environment variables that are used later by applications. In addition, your AUTOEXEC.BAT file might 
set your MS-DOS prompt or start pop-up programs such as Borland's SideKick.



<< button          

Displays the previous topic in a series of topics, until you reach the first topic in the series. Then the 
button is dimmed. Use this button when you want to backtrack through topics the way they are 
organized in HyperGuide.



>> button          

Displays the next topic in a series of topics, until you reach the last topic in the series. Then the button is
dimmed. Use this button to move from topic to topic in the recommended order.



Back button          

Displays the last topic you viewed. HyperGuide moves back one topic at a time, in the order in which 
you viewed them.



base-level synthesizer
One of the two types of synthesizers accommodated by Windows.
MIDI files authored for Windows include two versions of a song: one version for base-level synthesizers 
and another version for extended synthesizers. The distinctions between base-level and extended 
synthesizers are based on the number of instruments and notes the synthesizer can play.



batch file
A file that runs a sequence, or "batch," of commands when you type its filename. All filenames of batch 
files end with the extension .BAT, even though you don't have to type this extension to run the batch file.



baud rate
Signalling speed measured by the number of signals per second.



bitmap          

An image stored as an array of bits.



branch          

A segment of the Directory Tree, representing a directory and any subdirectories it contains.



browse
To look through files and directories. In some dialog boxes, the Browse button shows a list of files and 
directories from which you can choose.



byte
The amount of memory space (normally 8 bits) that a computer needs to represent a single character or 
word.



cascading menu          

A menu that opens from a command on another menu.



CD-ROM
Compact Disc-Read Only Memory. An optical data-storage technology that allows large quantities of 
data (such as animations, images, music, and sound) to be stored on a compact disc similar to discs 
used by the music industry.



channel
MIDI uses channels to send messages to individual devices within a MIDI setup. There are 16 MIDI 
channel numbers. Devices in a MIDI setup can be directed to respond only to messages marked with a 
channel number specific to the device.



check box           

A small square box that appears in dialog boxes and can be selected or cleared. When the check box is 
selected, an X appears in the box.



choose
To use key combinations or your mouse to carry out a command in Windows. You often choose a 
command after you have selected an item or made it active.



Clipboard          

A temporary storage area in memory, used to transfer information. You can cut or copy information onto 
the Clipboard and then paste it into another document or application.



close
To reduce a document window or application window to an icon or, in some cases, to remove it from the 
desktop. You close a window by double-clicking the Control-menu box or choosing the Close command 
from the Control menu. When closing an application window, you can choose to save or abandon 
changes to the current document before you close it.



collapse
To hide a level of directory information in the Directory Tree window. When you first start File Manager, 
all directories but the root directory are collapsed.



command          

A word or phrase, usually found in a menu, that you choose to carry out an action.



command button          

A button in a dialog box that carries out or cancels the selected action. Two common command buttons 
are OK and Cancel. The button that carries out the action will often have a label that describes it (for 
example, Open, Create, Install). Another dialog box appears when you choose a command followed by 
ellipses.



command line
Information given to MS-DOS that specifies a command and all the pertinent information to carry it out. 
For example, to start Windows, you type win at the MS-DOS prompt.



complementary color
The color exactly opposite a color on the RGB color wheel. For example, the complementary color of 
blue is yellow.



compound device
Devices, such as the waveform audio driver, that have an associated file and require a filename 
specification when opened.



CONFIG.SYS
A file that defines device drivers and specifies your MS-DOS configuration. For example, a typical 
CONFIG.SYS file might specify the location of the MS-DOS file COMMAND.COM, define an extended 
memory manager, and specify how many files an application can have open at once. MS-DOS runs the 
commands in the CONFIG.SYS file each time you turn on your computer. Your CONFIG.SYS file is 
located in the root directory of your first hard disk, which is usually drive C.



Contents button          

Displays the HyperGuide contents.



Control menu          

The menu in the upper-left corner of a window. The Control menu appears on every application that runs
in a window and on some non-Windows applications. Document windows, icons, and some dialog boxes
also have Control menus.
Control menu commands move, change the size of, and close windows. You can also switch to Task List
by using the Control menu. For non-Windows applications, Control menu commands transfer 
information and perform other functions, depending on the application.



Control-menu box
The box located in the upper-left corner of a window. Clicking the Control-menu box opens the Control 
menu for the window.



conventional memory
The first 640K of memory that MS-DOS uses to run applications. Most computers have at least 256K of 
conventional memory and can accommodate up to 640K of conventional memory.



cutout          
A portion of a Paintbrush drawing you select with the Scissors or Pick tool.



data bits
The bits in each package of data sent between two computers during telecommunication. Most 
characters are transmitted in 7 or 8 data bits.



default button          

The command button in some dialog boxes that is automatically selected or chosen by Windows as the 
most logical or safest choice. The default button has a bold border, indicating that it will be chosen if you 
press ENTER. You can override a default button by choosing Cancel or another command button.



default printer
The printer that Windows applications automatically use when you choose the Print command. You can 
have only one default printer, which must also be the active printer on the port. The printer you use most 
often should be made the default printer.



desktop
The background of your screen, on which windows, icons, and dialog boxes appear.



desktop pattern
A geometric pattern that appears across your desktop. You can design your own pattern or choose one 
of the patterns provided by Windows.



destination directory
The directory to which you intend to copy or move one or more files.



device contention
When several applications simultaneously request use of a peripheral device, such as a printer or 
modem.
Windows automatically handles device contention when all the applications are Windows applications. 
When one of the applications is a non-Windows application, however, the conflict is handled according 
to the options you select in the 386 Enhanced dialog box. This dialog box appears when you choose the 
386 Enhanced icon in Control Panel.



device driver
Tells Windows how to control a piece of hardware. Using Control Panel, you can install device drivers for
your:

Display (monitor)
Keyboard
Mouse
Network



dialog box          

A rectangular box that either requests or provides information. Many dialog boxes present options that 
you must choose from before Windows can carry out a command. Some dialog boxes present warnings 
or explain why a command can't be completed.



directory path          

The directions to a directory or file within your system.
In the illustration, C:\ART stands for the ART directory on drive C. Any commands you use affect the files
and subdirectories in this directory.
When you want to specify a file, make sure the filename follows the directory path.



Directory Tree          

A graphic display of a disk's directory structure. The directories on the disk are shown as branching from
the disk's root directory.



Directory Tree window          

A File Manager window that shows the complete branching structure of the selected disk drive.



directory window          

A File Manager window that lists the contents of a specific directory. The directory window shows all the 
files and subdirectories contained in the directory.



disk-drive icon          

An icon in the Directory Tree window of File Manager that represents a disk drive on your system. 
Different icons depict floppy disk drives, hard disk drives, RAM drives, CD-ROM drives, and network disk
drives.



display box          

A display box is not an option, but a type of text box that shows an example of another option you have 
selected, in this case a sample of the 10 pt, underlined, Helvetica font.



document
Whatever you create with an application, including information you enter, edit, view, or save. A document
can be a business report, a spreadsheet, a picture, and so on.



document file          

Files that are associated with an application. You can start an application and open the associated file by
choosing a document file icon.



document window          

A window inside an application window. Each document window contains a single document or other 
data file. There can be more than one document window inside an application window.



DOS
Disk Operating System, typically known as MS-DOS (Microsoft) or PC-DOS (IBM). This is the underlying
software that must exist for your PC to operate.



drag
A mouse move. You drag a Windows element by pointing to it, holding down the mouse button, and 
sliding the mouse from one spot on the surface of your desk to another and releasing the mouse button.



drop-down list box
A list box that opens and closes in dialog boxes.
Before you open a drop-down list box, it looks like this:

After the list box is open, it looks like this:

NOTE: When the list is longer than the box, scroll bars are provided.



error checking
A method for validating transmissions.



expand
To show hidden directory levels in the Directory Tree. With File Manager, you can expand a single 
directory level, one branch of the Directory Tree, or all branches at once.



expanded memory
Memory in addition to conventional memory that is available to applications. It is allocated in 16K blocks.
Windows makes use of expanded memory only if the /r switch is used at startup. Windows running in 
386 enhanced mode simulates expanded memory for the applications that need it. Windows running in 
standard mode or 386 enhanced mode allows applications to use expanded memory, but does not use 
expanded memory itself in managing applications.



extended memory
Memory in addition to conventional memory that is not readily accessible to MS-DOS or MS-DOS 
applications. Extended memory cannot be used on 8086 and 8088 computers. Windows running in 
standard mode or 386 enhanced mode uses extended memory to manage and run applications.



extended synthesizer
One of the two types of synthesizers accommodated by Windows.
MIDI files authored for Windows include two versions of a song: one version for base-level synthesizers 
and another version for extended synthesizers. The distinctions between base-level and extended 
synthesizers are based on the number of instruments and notes the synthesizer can play.



extension
Part of a file or directory name that appears after a period and provides additional information. It usually 
indicates the type of file or directory. For example, program files have default extensions of .COM 
or .EXE .
Many applications include a default extension automatically when you save a file the first time. For 
example, Notepad adds a .TXT extension to all filenames unless you specify otherwise.



file
A document or application that has been given a name. All documents are stored as files in Wiindows.



file information line          

Information specific to each file in a print queue. The information can include these details:
The file's position in the queue or a printer icon if the file is printing.
The title of the print job assigned by the application (if your network software supports this).
What percentage of the file has printed so far.
The size of the file in kilobytes (if the Print File Size command on the View menu is selected).
The time and date you sent the file to Print Manager (if the Time/Date Sent command on the View

menu is selected).
If you are connected to a network printer, the printer queue information line shows the network server 
connection. Any detailed information the network can provide appears in the message box at the upper-
right corner of the Print Manager window. Networks can provide varying degrees of detailed information.



flow control
The method for controlling the flow of information.



font          
A graphic design applied to all numerals, symbols, and characters in the alphabet. A font usually comes 
in different sizes and provides different styles, such as bold, italic, and underlining for emphasizing text.



font size
The height of a printed character, measured in points. One inch equals 72 points. For example, 12-point 
Helv is 12 points high.

The font and font size you use determine the amount of text that fits on one page. 



format
(1) The appearance of text on the pages of a document. (2) To prepare a disk so it can hold information. 
Formatting a disk erases all information that was previously on it.



full-screen application
A non-Windows application that uses the entire screen--rather than a window--to run in the Windows 
environment.



General MIDI Mode standard
A MIDI specification controlled by the MIDI Manufacturers Association (MMA). The purpose of this 
specification is to enable MIDI file authors to create files that sound the same across a variety of 
different synthesizers.



group
A collection of applications within Program Manager. Grouping your applications makes them easier to 
find.



group icon          

A group window you have reduced to an icon in Program Manager.



group window          

A window that displays the items in a group within Program Manager. These items can be applications, 
files associated with applications, or a combination of both.



History button        

Displays a list of the HyperGuide topics you have viewed. Use this button to revisit any of the last 40 
HyperGuide topics you have viewed. The most recent topic appears first.



hotspot
Text, graphics, or parts of graphics that provide links to other HyperGuide topics or more information 
about the current topic.
Whether text or graphics, the pointer changes to the shape of a hand whenever it is over a hotspot. If 
you click a hotspot that is linked to another topic, that topic will appear in the HyperGuide window. If the 
hotspot is linked to more information, HyperGuide displays the information in a popup window on top of 
the HyperGuide window.



hue
The position of a color along the color spectrum.



HyperGuide button bar          
Contains the HyperGuide buttons you use to move among topics and contents screens. It is located 
near the top of the HyperGuide window.



icon          

A graphic representation of a disk drive, directory, group, application, document, and so on. You can 
restore an application icon to a window when you want to use the application.



insertion point          
The place where text will be inserted when you type.The insertion point usually appears as a flashing 
vertical bar in an application's window or in a dialog box. The text you type appears to the left of the 
insertion point, which moves to the right as you type.



International MIDI Association (IMA)
The non-profit MIDI organization that circulates information about the MIDI specification.



keymaps
Percussion instruments are key-based--each note plays a different percussion instrument. Keymaps 
translate MIDI key values to ensure the proper percussion instruments are used to play MIDI files. All 
MIDI files for Windows are authored using standard key assignments based on the General MIDI Mode 
standard.



keyword
Words in the HyperGuide Search dialog box that are associated with topics. Each application's 
documentation has its own keyword list, including the glossary words in HyperGuide. You select from the
list of keywords or type a keyword to see the list of topics associated with that keyword.



kilobyte
The measurement used for the size of a computer's memory, where 1 kilobyte (K) = 1,024 bytes.



list box          

A box within a dialog box that lists available choices--for example, the list of all available files in a 
directory. If all the choices don't fit in the box, there will be a vertical scroll bar to the right of the list box. 
In some list boxes, you can select more than one item.



local printer
A printer that is directly connected to your printer by a cable.



local queue          

Lists the files that you directed to any active printer connected to your computer. The computer and 
printers are connected locally by a cable.
When Print Manager starts printing on a local printer, its icon appears at the bottom of your screen. If 
you restore the icon to a window, you see the print queue for any active printer connected to your 
computer. You can use the Print Manager window to check the status of files in the print queue or to 
interrupt or cancel a print job.



luminosity
The brightness of the color on a scale from black to white.



maximize
To enlarge a window to its maximum size by using the Maximize button or the Maximize command.



Maximize button          

The small button at the upper-right corner of a window that contains an Up arrow. Mouse users can click
the Maximize button to enlarge a window to its maximum size. Keyboard users can use the Maximize 
command on the Control menu.



Media Control Interface (MCI)
A standard control interface for multimedia devices and files. MCI allows a multimedia application to 
easily control a variety of multimedia devices and files.



memory
The space in a computer where information is stored while you are working with it. Most PCs have a 
small amount of read-only memory (ROM), containing the built-in programs that start the operation of 
the computer when it is turned on, and a large amount of random-access memory (RAM) for users' 
programs and data.



menu          

A list of available commands in an application window. Menu names appear in the menu bar near the 
top of the window. The Control menu, represented by the Control-menu box at the left end of the title 
bar, is common to all Windows applications. You use a command on a menu by selecting the menu 
name, then choosing the command you want.



menu bar          
The horizontal bar containing the names of an application's menus. It appears just under the title bar.



menu command          

A word or phrase in a menu that you choose to carry out an action, such as copying a file.



menu name
The name for a particular menu that appears in the menu bar and opens a menu when you choose it.



menu title
A word or phrase in the menu bar that identifies a group of commands. Selecting the menu title causes 
the title to be highlighted and its menu of commands to appear below it.



MIDI
Musical Instrument Digital Interface. MIDI sets a communications standard for transferring data between
musical instruments and associated devices.



MIDI file
A file format for storing MIDI songs. In Windows, MIDI files have a .MID filename extension. 



MIDI Mapper
A Control Panel option that lets you create and edit MIDI setup maps. Windows uses these maps to 
translate and redirect MIDI data. 



MIDI Sequencer
Software that creates or plays songs stored as MIDI files. When a sequencer plays MIDI files, it sends 
MIDI data from the file to a MIDI synthesizer that produces the sounds. Windows provides a MIDI 
sequencer to play MIDI files.



MIDI Manufacturer's Association (MMA)
A collective organization composed of MIDI instrument manufacturers and MIDI software companies. 
The MMA works with the MIDI Standards Committee to maintain the MIDI specification. 



minimize
To reduce a window to an icon using the Minimize button or the Minimize command. The document or 
application remains open (or running), and can be the active application or document.



Minimize button          

The small button at the upper-right corner of a window that contains a Down arrow. Mouse users can 
click the Minimize button to reduce a window to an icon. Keyboard users can use the Minimize 
command on the Control menu.



movie file
A multimedia data file (for example, a file with the .MMM extension). You can play movie files with the 
Media Player accessory. Movie files are also called animations. 



MSCDEX
Microsoft Compact Disc Extensions. MSCDEX is software that makes CD-ROM drives appear to DOS 
as network drives. You must have MSCDEX installed on your computer for the CD-ROM drive to work. 



multimedia extensions
Additional features added to Windows version 3.0 that enable your computer to run animations, play 
sound and MIDI files, and display high-quality images. 



Multimedia PC
Multimedia personal computer. A multimedia computer satisfies a minimum set of hardware/software 
requirements necessary for multimedia computing. The requirements include:

An 80286/386/486 microprocessor running at 10MHz or faster
2MB or more of RAM
30MB or larger hard disk
VGA display
A digital audio subsystem
A CD-ROM drive
Systems software compatible with Microsoft Windows version 3.0 with multimedia extensions



multitasking
The ability of a single computer to perform several tasks simultaneously.
Multitasking makes it possible to print one document while editing another, or to perform lengthy 
computations while you work on something else.



network printer
A printer that is accessible to your computer only through a network.



network queue
Lists the files on the network server if you are using a network printer.



network server
A computer on a network that provides a particular service to other computers. For example, a disk 
server manages a large file server, and a print server manages a printer.



non-Windows application
An application that was not designed to run in Windows. Generally, non-Windows applications do not 
conform to Windows user-interface standards.



open
To display the contents of a directory or file in a window, or to enlarge an icon to a window.



option button           

A small round button that appears in a dialog box and is used to select an option. Within a group of 
related option buttons, you can select only one button.



palette
Defines the colors used in a bitmap image. Every device independent bitmap (DIB) has an associated 
color palette. 



parity
The method of detecting errors in data transmission.



patch
A specific sound created by a synthesizer. A synthesizer plays notes using sounds defined as patches.



patchmaps
A patch is a specific sound created by a synthesizer. A synthesizer plays notes using sounds defined as 
patches. Patchmaps translate MIDI patch changes to ensure the proper instruments are used to play 
MIDI files. All MIDI files for Windows are authored using standard patch assignments based on the 
General MIDI Mode standard.



pathname
The directions to a directory or file within your system. For example, C:\WINDOWS3\APPTS\JUNE.CAL 
is the pathname of the JUNE.CAL file in the APPTS subdirectory in the WINDOWS3 directory on drive 
C.



picture elements
The smallest graphics unit on the screen. Also known as pels.



pixels
The smallest graphic units on the screen. Also known as picture elements (pels).



playlist
A list of compact disc titles and tracks that determines the order in which the tracks on the disc are 
played. Playlists are only used in Music Box.
Use the Program button to assign or edit titles, and to change the playlist.



pointer          
In Windows, the shape of the pointer indicates its function.

For selecting Windows items, scrolling, resizing windows, 
and moving windows and dialog boxes with your mouse. 
This is the pointer you will see most often.

For choosing a HyperGuide hotspot.

For selecting text with your mouse.

For changing the size of a window with your mouse.

For changing the location or size of a window with your 
keyboard.

For indicating the application is processing your request.

port
A connection on a computer where you plug in a cable that carries data to a device.
LPT ports are parallel ports. COM ports are serial ports. EPT is a port used for certain printers, such as 
the IBM Personal Pageprinter. You can use the EPT port only if you have installed a special card in your 
computer.
Multimedia PCs also have a port for a MIDI sequencer.



print options
Printer-specific settings such as page orientation--portrait or landscape--or the manner in which paper 
feeds through the printer. These options vary from printer to printer.



printer-driver file
A file that gives Windows important information about how to control your printer, including details about 
printer features and the printing interface, descriptions of fonts (such as sizes and styles), character 
translations, and control sequences the printer uses to achieve various formats. Windows has printer-
driver files for most commonly used printers.



printer font
A series of dots connected by lines that can be scaled to different sizes. Another name for printer fonts is
vector (or stroke) fonts. Plotters typically use vector fonts.



printer queue information line          

Indicates the following:
The name of the printer.
Where the printer connects to your computer.
The current status of the printer.



program file          

A file that contains information that controls an application. In File Manager, each program file is 
represented by an icon. You can start the application by choosing the icon. Filenames for program files 
can have these extensions: .EXE, .COM, .PIF, and .BAT.



program information file (PIF)
A file that provides important information that Windows needs to run a non-Windows application. PIFs 
contain information such as the name of the file, a startup directory, whether the program writes directly 
to the screen or to memory, and multitasking options for applications running in 386 enhanced mode.



program item          

A program file or associated document represented by an icon in Program Manager. The program item 
provides the instructions Windows needs to start an application and open a document (if specified) when
you choose the icon.



program item icon          

An icon representing an application you can start or an associated document you can open from a group
in Program Manager. The program item provides the instructions Windows needs to start an application 
and open a document (if specified) when you choose the icon.



RGB components
The amount of each of the three primary colors--red, green, and blue--present in a color. Every color and
pattern is made by varying the three primary colors. This is true even in monochrome (black and white) 
mode. For instance, white is made by mixing together 255 parts of red, 255 parts of green, and 255 
parts of blue. Black, on the other hand, is 0 red, 0 green, and 0 blue.



read-only
Describes a file or CD-ROM disc that can only be opened and read. You cannot edit a read-only file or 
CD-ROM disc and save your changes.



real mode
An operating mode that Windows runs in to provide maximum compatibility with versions of Windows 
applications released prior to Windows version 3.0. Real mode is the only mode available for computers 
with less than 1 MB of extended memory.



Restore button          

The small button at the upper-right corner of a window that contains both an Up arrow and a Down 
arrow. The Restore button appears only after you have enlarged a window to its maximum size. Mouse 
users can click the Restore button to return the window to its previous size. Keyboard users can use the 
Restore command on the Control menu.



root directory
The main directory on a disk. The root directory is created at the first level when you format a disk. The 
symbol used to indicate the root directory of a disk is the backslash (\). For example, the root directory 
for drive C is noted as C:\.



sample
A piece of waveform data represented by a single numerical value. You convert sound into digital form 
by taking samples of the sound at specific time intervals and converting them to numeric values.



saturation
The purity of a hue, moving from gray to the pure color.



scaled font size
A font size that approximates a specified font size for use on the screen. Windows scales larger font 
sizes when a size that is available for the printer is not available for the screen. Scaled fonts may look 
slightly different from unscaled fonts. When you choose a smaller font size that is available for the printer
but not for the screen, Windows substitutes the correct size from a precision-drawn font that resembles 
the selected font as closely as possible.



screen font
A font that duplicates a printer font on your screen.

If you choose a printer font that does not have a corresponding screen font, Windows substitutes a 
screen font that closely resembles the printer font. The substitute font duplicates the line lengths and 
page breaks of the font you selected.
When you purchase extra fonts from a printer or font manufacturer, ask about the availability of screen 
fonts to match.



screen saver
An image or pattern that is shown on your computer screen during periods of inactivity. Screen savers 
hide information currently on the screen; by changing patterns they can also save wear on the 
electronics in the display.



scroll arrow          

An arrow on either end of a scroll bar that is used to scroll through the contents of a window or list box. 
Clicking a scroll arrow moves the contents one line. Holding down a scroll arrow scrolls the contents 
continuously.
Scroll arrows also control the playing of media in some applications, such as Media Player and Sound 
Recorder.



scroll bar          
A bar that appears at the right and/or bottom edge of a window whose contents aren't completely visible.
Each scroll bar contains two scroll arrows and a scroll box, which allow you to scroll within the window or
list box.
A scroll bar is also used to control playing of media in some applications, such as Media Player and 
Sound Recorder.



scroll box          

The square or rectangular box within a scroll bar that indicates your relative position within a document 
or list box. Mouse users can drag the scroll box up or down quickly through long documents.
A scroll box is also used to control playing of media in some applications, such as Media Player and 
Sound Recorder.



Search button          

Displays the keywords you can use to search for topics. Use this button to look for topics related to a 
keyword.



select
To mark an item by highlighting it with key combinations or with a mouse. Selecting does not initiate an 
action. After selecting an item, you choose the action that affects or involves the item. For example, you 
can select text and then choose the Copy command to copy the text onto the Clipboard.



selection cursor          
The marking device that shows where you are in a window, menu, or dialog box and what you have 
selected. The selection cursor appears as a dotted box around the text in a dialog box option.



serial ports
Ports used by your system, named COM1, COM2, and so on. Serial ports are typically used for 
connecting modems, mouse devices, and some kinds of printers.



shortcut key          

A key or key combination, available for some commands, that you can press to carry out a command 
without first selecting a menu. The shortcut key for a command is listed to the right of the command 
name on the menu.



shrink
To reduce a window to an icon using the Minimize button or the Minimize command. The document or 
application remains open (or running), and can be the active application or document.



simple device
Devices, such as audio compact-disc players, that don't have an associated file and can be opened 
without a filename specification.



solid color
A color directly supported by your display.



source directory
The directory containing the file or files you intend to copy or move.



spin box          

A spin box shows one item in a range of possible choices. Clicking the Up or Down arrow to the right of 
the entry lets you "spin" through the available choices until your choice appears in the display rectangle.



standard mode
The normal operating mode for running Windows. This mode provides access to extended memory. In 
standard mode, you can also switch among non-Windows applications.



status bar          
A line of information located at the top or bottom of a window. For example, in a directory window the 
status bar tells how many files are selected, how much disk space they occupy, and the total number of 
files in the directory. In the Directory Tree window, the status bar shows the number of bytes available on
the disk and the total disk capacity. Not all windows have a status bar.



stop bits
The timing unit between characters.
Stop bits are not actually bits; they determine the time between transmitted characters.



synthesizer
An electronic instrument able to make music and sounds by creating its own audio waveforms and 
sending them out to an audio system. A synthesizer can play back MIDI files.



Task List
A window that shows all the applications you have running so you can switch among them. You can 
open the Task List window by choosing Switch To from the Control Menu or by pressing CTRL+ESC.



text box          

A box within a dialog box where you type the information needed to carry out a command. When the 
dialog box appears, the text box may be blank or may contain text.



text file
A file containing only plain text, numbers or symbols. The text in a text file is uniform and does not 
contain any formatting, such as bold, underline, or different fonts and font sizes. A text file usually 
consists of characters coded from the ASCII character set. 
The advantage of a text file is that it can be transferred to almost any text editor or word processor. Also,
MS-DOS and Windows use text files, such as AUTOEXEC.BAT, CONFIG.SYS, and WIN.INI.



title
Another name for a software application written to run on a Multimedia PC. 



title bar          
The horizontal bar at the top of a window that contains the title of the window or dialog box. On many 
windows, the title bar also contains the Control-menu box and Maximize and Minimize buttons.



topic
The level in the HyperGuide hierarchy at which you see information in the main window. This information
can be in the form of a Quick Look graphic, an explanation of a command, a conceptual overview, a 
procedure, or a table of keys. Information in pop-up windows and contents screens are not considered 
topics.



track
A sequence of sound on a CD disc, which usually corresponds to a song.



Up button          

Moves up one level in the HyperGuide hierarchy.



vector fonts
A series of dots connected by lines that can be scaled to different sizes.



virtual memory
A memory management system used by Windows running in 386 enhanced mode, which allows 
Windows to behave as if there were more memory than is actually present in the sytem. Virtual memory 
equals the amount of free RAM plus the amount of disk space allocated to a swap file that Windows 
uses to simulate additional RAM.



volume label          
The name you give a disk by using the Label command. Disk labels are optional. You see this 
information in File Manager only if you assigned a label to your disk. You can change or add a disk label 
through File Manager.



WAVE format
Microsoft's format for digitized waveform files. These files have a .WAV extension.



waveform
A sound waveform displays variances in air pressure over time. An audio signal waveform displays 
variances in voltage over time.



wildcard characters
Two MS-DOS characters you can substitute for all or part of a file or directory name when you want to 
find similarly-named files or want one command to affect a number of files or directories.
An asterisk (*) substitutes for all characters. A question mark (?) substitutes for a single character.
For example, this entry covers all files with a .DOC extension in the current directory:

*.DOC
And this entry covers everything named with FY, three other characters, and the extension .90:

FY???.90



window
A rectangular area on your screen in which you view an application or document. You can open, close, 
and move windows, and change the size of most windows. You can open several windows on the 
desktop at the same time and you can shrink windows to icons or enlarge them to fill the entire desktop.



window border          
The outside edge of a window. You can lengthen or shorten each border. You can also change the width 
of the border with Control Panel's Desktop command.



Windows application
An application that was designed for Windows and will not run without Windows. All Windows 
applications follow the same conventions for arrangement of menus, style of dialog boxes, use of the 
keyboard and mouse, and so on.



wrap
The automatic movement of the insertion point from the end of one line to the beginning of the next line 
as you type. When text wraps, you do not need to press ENTER at the end of each line in a paragraph.






